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Introduction

Thank you for choosing WINLIVE PRO SYNTH 14 by Promusicsoftware, the first musical repertoire
management program whose first version dates back to November 6%, 1994. The intention of its
founder, Leonardo Di Pinto, was to create a program that could work with different file formats
then to manage them in a simple and immediate way.

WINLIVE PRO SYNTH 14 version, available for both Windows and Mac OSx, is designed for a
professional use. Thanks to its last update, it is particularly appreciated by singer-performers, who
require a reliable program to manage their own musical repertoire, compatible and adaptable to
their proper tools in order to look like being on stage.

Karaoke enthusiasts, who want to customize their performances, also appreciate it very much.
PRO SYNTH is WINLIVE’s commercial version, therefore third parts assignment, unlawful copy of
the license and any other copyright piracy action concerning the software are forbidden.

Reverse Engineering implementation, code and graphic resources editing as well as reproducing all
files even partially are forbidden and open to legal prosecution.

We decline any responsibility from using the software improperly and/or damaging the operating
system as well as losing data.

To know more, visit our website:
Www.promusicsoftware.com

WINLIVE is a Pro Music Software brand


http://www.promusicsoftware.com/

Installation and requirements

To install WINLIVE just run the setup and then follow the instructions on the screen.
Normally, at the end of the installation, the software requires the entry of your PERSONAL
ACCOUNT and the SERIAL NUMBER, sent via email at the time of purchase.

Winlive License

WINLIVE Professional Edition 14 Synth

Personal Account

Serial Number

E-mail

Surname

First name
Computer name PC-DESKTOP

Software ID Enter Personal Account and Serial Number

An internet connection is required to obtain the license key.
If the PC is connected to the internet, complete the fields and press’ Activate Winlive '

If the PC is not connected to the internet, carry out the following steps

1- Complete the 'Personal Account’ and "Serial Number' fields with the codes provided

2- Connect to the site through the link or directly from the 'Activations’ section of www.promusicsoftware.com
3- Continue the navigation and eventually insert the data if incomplete

4- Generate a new license and copy the "Winlive License' code in the program

5- Finish with 'Register’

| don't have the
Try DEMO DEMO OMNLINE code

Click on the TRY DEMO button to choose the demonstrative mode, in case you do not have the
license, in order to discover all Winlive features. DEMO version has a limited use (it can only
manage 20 songs) and its public use is expressly forbidden. FULL version has no restrictions.

The DEMO ONLINE button allows the PROMUSICSOFTWARE operator, once connected ONLINE
with the user, to provide a demonstration that must be booked by email, phone or whatsapp.

If on click on | DO NOT HAVE THE CODE you can proceed to the eventual purchase of the program.



In order to activate the program you need, however, an Internet connection from a networked
device even if not properly from the PC itself where WINLIVE will be installed

Internet connection is necessary to activate the software. When the computer is connected to the
internet, you can simply entry PERSONAL ACCOUNT, SERIAL NUMBER, and all required data.
When an SOFTWARE ID appears, you just need to click on:

ACTIVATE YOUR COPY OF WINLIVE HERE.

If your computer is not connected to the internet, you should install software setup, then insert
PERSONAL ACCOUNT, SERIAL NUMBER, and all required data. For computer name we can write
anything so as to identify the PC in question.

At this point, an SOFTWARE ID will appear. From any device connected to the internet, connect to
our website:

WWWw.promusicsoftware.com

Go to Activations=> insert PERSONAL ACCOUNT and SERIAL NUMBER to log in your personal
account. Click on NEW ACTIVATION, so insert the SOFTWARE ID generated by the program. Then
a license number will appear. Copy it and paste it in the blank line as required by the program.

FOR EACH LICENSE YOU WILL RECEIVE, VIA EMAIL, ACTIVATION CODES FOR THE PROGRAM.

YOU CAN USE UP TO 2 ACTIVATIONS PER LICENSE EVEN ON DIFFERENT COMPUTERS.
ACTIVATIONS CAN BE MANAGED |INDEPENDENTLY WITHOUT THE INTERVENTION OF
PROMUSICSOFTWARE STAFF

TRANSFERRING YOUR ACTIVATIONS TO THIRD PARTIES IS PROHIBITED.

ADDITIONAL EXTRA ACTIVATIONS CAN BE PURCHASED DIRECTLY FROM THE PROMUSICSOFTWARE
SITE.

EXTRA ACTIVATIONS REFER TO THE CURRENT VERSION AND CANNOT BE CARRIED OVER TO LATER
VERSIONS.

For additional info please contact Promusicsoftware.

Watch the video tutorial to learn more about the installation of the software

= hitps://youtu.be/KY4INKBAdAK

* System requirements recommended for Windows: Ram 4Gb, 200 Mb Free space on Hard Drive, CPU i3 or better
* System requirements recommended for Mac: Ram 4Gb, 1200 Mb Free space on Hard Drive, CPU i3 or better

* Compatible with Windows 7, Windows 8/8.1, Windows 10 and Windows 11, 32 or 64 bit
* Compatible with Mac osX (tested from High Sierra to Sonoma)

** Multitrack management not compatible for Apple Mac with ARM M-series processor (M1, M2, M3)
** Note for Apple Mac users: some functionalities may be different o may be not present on mac version
compared to the Windows PC version

Note: the recommended system requirements grant the functioning of the software and the execution of the songs by
the program but it could be necessary to deactivate all graphic effects to get a better performance, which could
decline substantially during the reproduction of CDG or VIDEO files.

The software could work with older versions of Windows but correct functioning is not granted.

* Without the recommended system requirements, starting the program could result slower due to the swapping on
the HD and the slowness of the processor.

* Some antivirus could slower the initiation of the program. If the software stucks on start on “Check Antivirus” for a
long time, deactivate the antivirus temporarily.


http://www.promusicsoftware.com/
https://youtu.be/KY4lNKBAdAk

Functionalities

WINLIVE PRO SYNTH is not just a Karaoke software but also a feature-rich music player and
management program. WINLIVE PRO SYNTH provides a real-time playback management.
Synchronized lyrics and chords contained in the files are easy to see and read. It is also possible to
synchronize lyrics and chords on empty files or on files that do not provide them at first. WINLIVE
PRO SYNTH manages up to 42 playlists, named SONGLIST, of which 39 in Database, 1 temporary
(F10) and 2 Song Folder List (F11 and F12 for external loadings outside of the database). It is
possible to act on different parameters of a music file: you can start and stop it at any time,
change the rhythm, the tone (any format audio and video), the instruments, the volume, the pan,
etc.... till the single drum notes, everything in real time!

Great improvement in the listening of Midifiles is provided by our Synthesizer software (Winlive
Synth) included in the program aiming to get obtain a real sound.
Media Explorer mode is strengthened, in order to let you manage the files directly from HD or
external drive, avoiding a prearranged database needed to import them. We mainly recommend
this mode to those who enjoy Karaoke and manage dozens and dozens of files.

We recommend to our users not to use illegal copies of the software, reminding
not only that holding software without any number of registration is a criminal
offence, but also that the same pirate software contain dangerous virus that can
cause system crash.

We remind, instead, to all our registered WINLIVE PRO SYNTH 14 users that they have access to
120 minutes of free remote assistance. Our operators can interface directly with the users to show
them the countless features of Winlive. It is one of the most appreciated services by our users.

Remote assistance, YouTube services, Cloud Storage and the use of the Winlive Remote Control
APP are free additional services dedicated exclusively to those who have the latest updated
version and are therefore no longer provided in previous versions. These free services are
available until the end of MARCH 2025.

It is recommended, however, to upload the latest version to keep “up’’ with the continuous
innovations of Winlive And keep the additional services free.



Main features of WINLIVE PRO SYNTH 14

(The ones in bold are the new features compared to the previous version)

PLAYER section

- Professional multimedia player (midi, kar, mp3, mp3+irc, wav, cdg, cdg.zip, wmt, avi, mpg, mp4, flv, wma, Irc, txt, rtf,
jpg, gif, bmp, ytb youtube, pdf)

- Multitrack audio reading up to 16 tracks and creation of a single exclusive .wmt file (Winlive Multi Track) including
any txt and pdf files

- Import text in TXT, RTF, PDF format (electronic music-stand)

- Grooves import in both midi and audio formats

- Management of Youtube direct links within Winlive

EDIT

* KEY TRANSPOSE AND TEMPO FOR MIDI FILES, AUDIO, AUDIO MULTITRACKS AND VIDEO
- Event Management to associate specific events to midi, audio and video files

* NEW IMPLEMENTATIONS FOR EVENT MANAGEMENT: VOLUME EDIT FOR MULTITRACKS
* VISUAL TRACKS: graphic display of events within the song.

- Customizable midi channel output for each midi file

- Customizable precount for each midifile

- PAN assignment to audio outputs (ability to set outputs to L, R or L + R). Eg. it is possible to direct the backing track to
the left channel and the drum click to the right channel

- Ability to change audio output to individual midi synth channels (windows only)

- Management of 10 markers for each song

- MPX function for audio files with tracks divided into left and right

DATABASE

- Management of your repertoire divided into 39 songlists + 1 temporary so that you can save and later quickly recall
your songs with all the changes you have made.

* DATABASE SYNCRO: DATABASE BACKUP AND SYNCHRONIZATION FROM ONE PC TO ANOTHER.

Free 10 Gb of cloud space is provided for synchronizing one's database, including songs and attached files, from a
primary PC to a secondary PC.

The files and the related database will be kept online for 30 days from the time of upload.

- Search for duplicate files

MEDIA EXPLORER

- Media Explorer function for direct access to backing tracks without using the database
- In media explorer check for the presence of text before playing a file

- Ultra fast search in Media Explorer with new criteria

- Creation of customized lists with saving in the Media Explorer

* ALSO SORT BY FILE TYPE

LYRICS AND CHORDS

- Lyrics and chords insertion for Midi and Mp3 (physically stored in the file)

* INSERTING LYRICS AND CHORDS DIRECTLY INTO A MULTITRACK AUDIO FILE (WMT)

- Auto chords recognition from midifiles

- Display chords on the text (midi and audio)

- Synchronization of lyrics for video files (lyrics and chords in the upper and lower edges of the video)
- View chords in guitar tab

- Ability to associate a text, image or pdf to an Audio or Midi

- Score for single track selectable and stored for each song

- View mode as songbook with synchronization

- New ways of displaying texts

* IN EDIT MODE NEW FUNCTIONS AND DISPLAY OF THE LYRICS AND CHORDS IN THE SAME SCREEN
* POSSIBILITY OF SAVING THE CHORDS IN THE MIDI FILE IN DIFFERENT FORMATS (SOLTON, YAMAHA XF,
GENERALMUSIC, ETC)

- Scrolling text ** Only Windows

- Images as a moving background can be recalled randomly even from an image folder

- Programmable zoom for each pdf linked to the song

- Dual monitor support (karaoke monitor) for Video and CDG files too-



- Clone monitor of main monitor or karaoke monitor

- Melody preview bar

- SongService (M-live) format compatibility (lyrics and chords)
- Flowing subtitles management for karaoke monitor

SYNTH SECTION

* NEW INTERNAL GS/GM+ SOUND BANK OF HI-QUALITY WAVETABLE (SFX SOUNDS INCLUDED)

* WAVETABLE WITH 47 DRUMKITS AND 362 SOUNDS IN 110 MB

* NEW AND MORE AND MORE PERFORMING SOUNDS TO INCREASE THE QUALITY OF YOUR MIDIFILES
- Customize sound mapping

- User sound editor for the creation of new sound banks

- User drumkit editor for new drumkits creation

- Management of up to 16 different devices for midi

- Possibility to edit the individual notes of the drum track

- Midi Cover function to vary in the midifiles the choice of instruments according to the selected style.

- Implementation of low latency WASAPI drivers

- New implementations for connecting a midi keyboard to the PC (MIDI IN. Only PC Windows)

- Winlive digital piano with 4 part Synth and new functions (Only PC Windows)

- ASIO Driver management

- Convert MIDI to Wave or Mp3 directly with karaoke and chords included

- Main volume, Compressor, filter enhancer on Midi Engine

- Delay effect management on every midi track

- Multi effect management on sounds from inner Synth with more than 20 selectable MFX on every midi track

METRODRUMMER

- Metrodrummer (drum machines with preset rhythms) and midifiles synchro possibility
- Midi remix style using a library containing more than 320 rhythms

* NEW AVAILABLE RHYTHMS **(available soon)

- Possibility to easily replace the rhythm to a midifile and save it in the database

SAVE AND EXPORT

- Storing virtual or physical changes for each song (midi and audio)

- Convert midifile to wave or mp3 with lyrics, chords and markers included

- Saving separate tracks from midi to midi and from midi to audio with the possibility to generate and save the
metronome click

* SAVING FILES (MIDI, MP3, CDG, VIDEO) TO VIDEO FORMAT (AVI, MP4) WITH NEW FORMATS ALSO WITH SCREEN
CAPTURE

- Saving in lyrics3 ID3v1 format (e.g. Ketron instruments)

- Physical saving of markers in mp3 also from midi-> mp3 conversion

- Recording of an Audio track on Midi, Audio and video with the possibility of creating a single audio file **windows
only

- Saving video files to audio files (wav,mp3)

* EXPORT TO AUDIO OF A MULTITRACK FILE WITH EDITING (VOLUME, PAN, MUTE, TRANSPOSE)

* PHYSICAL SAVING OF VIDEO WITH START/END POINTS VIA MARKERS

FUNCTIONS AND OTHER

* RECORD AUDIO TO A VIDEO FILE AND SAVE IN VIDEO OR AUDIO

It is possible, for example, to record your voice or an instrument and save everything in a video or audio file.
- Medley creator to easily create medleys and save physically with lyrics and chords included

- Real-time mixing between midi, audio and video (excluding midi and midi)

- Evolved mixing editor with max 5 different live time liable to recall monitors

- Background playlist with automatic start in moments of pause

- Audio Samples editor for real-time insertion up to 100 samples (mediafiles)

- Detailed marker structure with text insertion, images, loops, jump key change at specific points
- Volumes compressor for both Audio and Midi Files

- Ability to match a midi to an audio and vice versa or 2 audio tracks together

- Synchronization of the linked video (timing start and seek)

- Specific views for Windows Tablets.

- Visual metronome



- WINLIVE DJ section with typical tools for dj's

- Preview the audio/video files on your secondary device (E.G. Headphones)

- Assignment of the midi melody to any midi channel (default midi channel 4)

- Images as background insertion

- Import of VanBasco playlists with tonal parameters, silent channels, etc.

- Quick icons programmable for an immediate access to other sections

- Winlive DJ Control mode with BMP recognition for Audio files with real time effects application
- Integrated video codec repair/installation function

- Display of notes on piano keyboard for educational use (midifile)

FREE ADDITIONAL SERVICES expiring on March 31, 2025

* Free space of 10 GB in CLOUD for DATABASE BACKUP AND SYNCRO

* WINLIVE REMOTE CONTROL app to remotely control the main Winlive functions (iOS and Android new release)
(available soon)

* Youtube functions (The Youtube service being provided by third parties may undergo changes without notice)
* 120 minutes of free remote assistance

IMPORTANT

FOR EACH LICENSE YOU WILL RECEIVE, VIA EMAIL, ACTIVATION CODES FOR THE PROGRAM.

YOU CAN USE UP TO 2 ACTIVATIONS PER LICENSE EVEN ON DIFFERENT COMPUTERS.

ACTIVATIONS CAN BE MANAGED INDEPENDENTLY WITHOUT THE INTERVENTION OF PROMUSICSOFTWARE STAFF
TRANSFERRING YOUR ACTIVATIONS TO THIRD PARTIES IS PROHIBITED.

ADDITIONAL EXTRA ACTIVATIONS CAN BE PURCHASED DIRECTLY FROM THE PROMUSICSOFTWARE SITE.

EXTRA ACTIVATIONS REFER TO THE CURRENT VERSION AND CANNOT BE CARRIED OVER TO LATER VERSIONS.

For additional info please contact Promusicsoftware.



File Menu

Info: WINLIVE can perform its songs in various ways.

1) We can play one or more songs by dragging them directly to the Performance screen. In this
way, by dragging a single file we could listen immediately while for multiple songs a temporary
Songlist will be created and then selecting the favorite song we could play it by pressing the enter
key.

2) We can load a single song from File menu and then Load File

3) We can explore our songs on our hard disks by selecting Media Explorer from the File menu.
This mode is ideal for those who want to play but with limited editing functions of the song. It is
mainly used for Karaoke performances (see Media Explorer paragraph);

4) The last way to perform our songs is to use the Database. This mode has made the Winlive
famous all over the world and is mainly used by musicians, singers and bands. With this mode it is
possible to save the many options that Winlive offers (see Database paragraph);

MULTI IMPORT IN DATABASE
You can select the various songs to be imported into the Database (see Database paragraph);

MEDIA EXPLORER
A section opens where you can explore the songs on our hard disks (see Media Explorer
paragraph);

LOAD FILE
It is possible to load a single song and play it immediately.

SAVE FILE
It is possible to save a single file in various ways (see Save File paragraph);

GENERATE SONGBOOK
A sheet is generated where the lyricst and any chords will be displayed (see Songbook paragraph);

FOLDER

Here you can load an entire folder of songs and associate it with special songlists that can be
recalled with the F11 and F12 keys. This function is very useful, for example, when we want to
view the contents of a USB key without loading it into our database



LOAD SONG AUDIO MULTRACK

This function allows you to load and manage a multitrack audio track made up of multiple audio
tracks (maximum 16). These tracks are enclosed in a folder. First we must open the folder and
choose one of the audio tracks where we could possibly insert lyrics and chords. All other tracks
will be loaded at the same time. Once the multitrack audio track has been loaded, a horizontal
mixer will open (visual mixer) where the various tracks will be displayed with the possibility of
varying the volumes.

SIbmin SOLmin7 SIbMaj7
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Also we could decide which tracks can undergo tonal changes. Obviously the rhythmic tracks must
not be transposed
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We can optionally save the entire multi-track song thus edited in a single file called WMT (Winlive
multi track) click on FILE-> Create or edit WMT file. In addition, we can associate a pdf or txt file
(for example we can associate a pdf score to the song)

Title Frank Sinatra - That's Life
Gen.Mote Created with Winlive

Artist Author

(Image or Pdf)

Text

WMT tracks :6
Main track vocals.mp3

Extract
Entract
Extract

Mot transposed

bass.mp3

A

CUE / LOCATORS
MO cue f locators

<

drums.mp3

<

guitar.mp3

%

Extract other.mp3

Extract

A

piano.mp3

£

At this point we could import it into the database and assign separate audio outputs if we have
connected a multi-channel sound card to our PC.

The separate audio outputs will be set in Tools-> Options-> Audio Options and by pressing the
mixer button we could establish on which audio channel each track could output

https://youtu.be/QoXKFH65T30?t=230

LOAD LIST F10

By clicking on this item it is possible to load those lists created in the temporary lists and recalled
with the F10 key. Remember that the temporary lists are emptied every time you exit the
program.

SAVE LIST F10
Here you can save temporary lists.

11


https://youtu.be/QoXKFH65T30?t=230

IMPORT IN DATABASE
If a song is loaded temporarily it is possible with this function to import it into the Database.

IMPORT IN DATABASE ALL F10
With this function it is possible to import an entire temporary F10 songlist into the database.

STOP AT THE END OF EACH SONG (Performance)
This parameter sets the STOP at the end of the song even if a song has been booked

STOP OF THE SONG EVEN IF BOOKED
This parameter sets the STOP at the end of the song even if a song has been booked

RANDOM NEXT SONG (Performance)
It is possible to set a random execution of the songs of the current songlist

DISABLE AUTOMATIC SONG START
By putting a check mark on this function, the song will not start automatically but will wait for our
start/play command.

PRIORITY MIDI KARAOKE FORMAT

Very often in a song there may be several lyrics, perhaps created with different programs. By
selecting the appropriate function, we establish whether we want to give priority to the standard
lyrics (meta events), to the songservice format of the Mlive (sysex) or let Winlive decide which
format to display (Automatic).

AUTOMATICALLY LOCK THE KEYBOARD
With this option the PC keyboard is locked. This function is very useful when you are far from the
PC in order to avoid that someone touching the keyboard may compromise our performance

MINIMIZE
The WINLIVE program is minimized to display the PC desktop

CLOSE
The program closes. In this case some parameters and the database are automatically saved

12



View menu

Through the menu View Mode, it is possible to choose the program’s operating mode:

PERFORMANCE [CTRL+ALT+P]: it is the playback mode used to control the various Song-List
playlists on startup, as well as the disposal of the song booking, the control the performance,
mixer and karaoke (see paragraph);

EDIT MODE [CTRL+ALT+E]: it is the mode used to edit different parameters of songs, lyrics, chords
and Markers (see paragraph);

MEDIA EXPLORER [CTRL+ALT+M]: it is the mode used to explore hard disks and eventually execute
files without inserting them in the Database (see paragraph);

DATABASE [CTRL+ALT+D]: it the collection of songs, used to organize and catalogue them;

The database stores the path of songs, their parameters, their changes and the insertion of any
images as background, texts or pdf combined to every song (see paragraph);

MODO STANDARD KARAOKE: In this mode the text and the chords are shown with different

display criteria, with the presence or absence of images as a background, prioritizing the graphic
aspect.

13



SONGBOOK MODE: unlike the standard mode, by selecting this mode it is possible to view the
music tracks like in a songbook with the synchronization and coloring of lyrics and chords. This
mode is recommended for those who want an easier lyrics reading and a precision in the position
of the chords in the same lyrics.

Winlive Pro 14.0

File View mode Tools Database Extra/Help Demo Songs Remote Suppc
=] SMP Elapsed  Total CountDown  Signature  Current

=/ @ Pt p |¢'+'l > Iﬂ 4:09:692 -03:48 N/A

C7 F Bb C7 F Bb C7

MY MOTHER WAS A TATLOR

F Bb c7 F Bb
SHE SEWED MY NEW BLUE JEANS

c7 F Bb c7 F
MY FATHER WAS A GAMBLIN' MAN

Bb C7 Bb C7 F Bb C7 F Bb C7
DOWN IN NEW ORLEANS

F Bb C7 Bb
NOW THE ONLY THING

C7 F
A GAMBLER NEEDS

Bb c7 F Bb C7
IS A SUITCASE AND A TRUNK

F Bb Cc7
AND THE ONLY TIME

F Bb
HE'S SATISFIED

c7 F Bb C7 F Bb C7 F Bb C7T F Bb C|
IS WHEN HE'S ALL A DRUNK

F Bb C7] F Bb C7 F Bb C7 F Bb C7 F
OH MOTHER TELL YOUR CHILDREN

1 o T |

a Songlist1-1 : i Kar U.Tozzi Lei (Songservice)

Il EH a4 kK
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To edit the various parameters (font, text color, chord colors, etc.) go to TOOLS—> and click on
SONGBOOK MODE SETTINGS

https://youtu.be/Fx1Y9TVAVIc?t=214

% Songbook Options -0 n

Font SIZE _Interline SIZE Orientation Chord color  Lyrics color Riempimento Backg color - ‘

: - Aaply

Other Windows—> EVENTS MANAGMENT [CTRL+ALT+V]

This function allows you to insert some events, sounds or functions in association with a midi,
audio or video file. For example, it is possible to insert, in a specific point of the song, a key
change, a picture or a pdf file, a sample, a change of a pdf page and so on in order to customize
your own musical performance.

Events Editor n

Menu

H <« » Kar U.Tozzi Lei (Songservice) Realtlme
Events

Event p1{0-255) p2(0-255) p3{0-255) pa{16bit) Text value
01 MIDI MESSA 0 0 o
02 MIDI SYSEX D7EFFO901F7
03 KEY CHANGE
04 TEMPO CHANGE

06 PDF PAGENLIM

7 STYLE REMIX

09 SONG VOLUME
10 REMOVE PDF/TXT/IME
11 ENABLE/DISABLE MET :
12 FADE OUT
13 START MIX

oo Qo Qo
Ln
tn
== == Ry = R e [ e |

[F=T: - - TR s B R TR I =]
0 o o o M
0 o ook

(=Y
(=]
[=1
(=1

Ending list

TIME - Milliseconds - - =

> SET 0 ‘

13 START MIX ~

MIX SetM 10 REMOVE PDF/TXT/IMAGE 3:Slow  4:Switch
5:0j mix] 11 ENABLE/DISABLE METRONOME
12 FADE OUT
3 START MIX
Delete
15 SUBTITLES / KARAOKE MONITORS
16 TXT/RTF PAGESCROLL
17 TRACK VOLUME



https://youtu.be/Fx1Y9TVAVIc?t=214

Select the type of event to insert from the drop-down menu at the bottom left:

The events currently available are:

01 MIDI MESSAGE: insertion of a midi message (for the type of midi event, consult a table of midi
parameters)

02 MIDI SYSEX: exclusive message

03 KEY CHANGE: change of key transpose

04 TEMPO CHANGE: tempo change

05 IMG / TXT / PDF: insertion of an image, a text and a pdf file. If ZOOM has been selected for the
associated pdf, the pdf will be divided into 2 parts: part A which represents the upper part of the
pdf and part B the lower part

06 PDF PAGNUM: change of page relating to the associated pdf

07 STYLE REMIX: insertion of a rhythmic style among those available in a midifile

08 CUSTOM SAMPLE: insertion of an mp3 or wave file

09 SONG VOLUME: volume of the song

10 REMOVE PDF / TXT / IMAGE: to remove the pdf file, the text or the associated image

11 ENABLE / DISABLE METRONOMIE: to enable or disable the metronome for midifiles

12 FADE OUT: inserting a Fade out (fading the volume)

13 START MIX: insertion of a start point to start mixing with the next song

14 NEXT-STOP: books the stop at the end of the song currently playing

15 SUBTITLES/KARAOKE MONITOR: allows a scrolling title to be inserted into the subtitle bar of
the karaoke monitor

16 TXT/RTF PAGE SCROLL: sets how many lines to advance or set a page change if a TXT or RTF file
is associated

17 TRACK VOLUME: allows you to change the volume of a single track for wmt (multitrack audio)
files

The TIME column indicates the insertion time of the event expressed in milliseconds.

The EVENT column indicates the type of event and the event parameters in the subsequent
columns.

After entering the events, press SAVE and a * .wevn file associated with the song file will be
created. When we play a song where events have been inserted, the EVENTS button will appear.

EVEMTS

D Z.Uers. 3.Vers 4.Chor 5.\Vers

MID  6Chor 7.Coda 3.Fine
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Other Windows—> VISUAL TRACKS [CTRL+ALT+T]

In this new function we can view the note events for each track in a midifile.

This way we can position ourselves with the mouse and press the left mouse button to hear the
relevant part.

With the right mouse button we can choose to isolate the track in question with the SOLO
function, enable all tracks with ALL ON, and disable transpose for the track in question (CHANNEL
NOT TRANSPOSED).

For audio files (mp3,wave and mp3-Cdg), even as a second matched track, the waveform will be
displayed and with the same mode we can position to the desired point.

The AUTO CHANGE PAGE function, if enabled, will allow automatic scrolling to the next page of
the Visual Tracks window.

Winlive Pro 14.0

File Visualizzazione Strumenti  Database Extra/Help Demo Songs Assistenza Remota  User: Promusicsoftware

= [_l Hapsed Total CountDown Signature Current
(it EEE@ 03:08  -02:39 9:4 Sotofondo
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Visual Tracks

31 *Romantic Tru

4:PanFlutesweer | |
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Frank Sinatra - That's Life
n
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‘
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Other Windows=> KARAOKE MONITOR [CTRL+K]

A second Winlive window will open, which you can drag on the second monitor; double clicking on
it will be set to full screen.

By right clicking on the main monitor screen you can change the character and mode of the
Karaoke Monitor, you can choose between:

e Multiline scrolling karaoke (only PC Windows);

¢ Winlive Classic: 2 lines;

* Modern Style: 4 lines;

¢ Music Stand: 4 lines + 1;

e Karaoke Zoom mode

* Line by line: 5 rows

* No Karaoke

Note: to make this function work correctly, from Windows imports, select the second monitor in
Extended Desktop mode. Refer to the video card help manual.

File View mode Tools Database  Extra/Help _ Demo Songs _ Remote Support User; Promusicsoftware O - & X

== =] Eapsed Total CountDown Signature  Current
-

I'VE TRAVELED EACH ANIL
Edim D Bmin7
AND MOREI MUCH MC I'VE TRAVELED EACH AND EVERY HIGHWAY

A7 Emin7
I DID I"‘iLnMY AND MORE, MUCH MORE THAN THIS

I DID IT MY WAY

Bmin7 DMaj7
REGRETS, I'VEH

F#dim

REGRETS, I'VE HAD A FEW

BUT THEN AGAIN, TOO FEW TO MENTION

Emin Emin7

Sophisticated Lady o 8 |7 uick

‘Quick Icons
o BBBM@M&B
o+

# -
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Other Windows=> CLONE MONITOR [CTRL+J]
By the clone monitor it is possible to clone the main monitor or the karaoke monitor so that it can
be viewed on a possible third monitor.

MY WAY -
v

EACH CAREFUL STEP AL

G Emin7 Gmin
D Bmin7
AND MORE, MUCH MC EACH CAREFUL STEP ALONG THE BYWAY

A7 EminZ AND MORE, MUCH MORE THAN THIS
IDID IT MY g i >
1 DID IT MY WAY

Bmin7 D
YES, THERE WEI YES, THERE WERE TIMES

DMaj7 A DMaj7 Amin?

G

RN« .| o on o .
] vy g
o] e ] o Lo e o o Lo e

MY WAY

To change the display source in Clone Monitor click on Screen Selection

Other Windows=> PIANO KEY [CTRL+K]

By clicking on this function, a piano keyboard is shown on the screen where the notes
corresponding to the midi track will be displayed.

Winlive Pro 14.0

View mode Tools Database _Extra/Help _ Demo Songs _ Remote Support ser: Promusicsoftware 1)) - & X|

MY WAY -

D IT ALL SO A Te
D DMaj7 Amin7
TO THINK I DID ALL THAT

AND MAY I SAY, NOT IN A SHY WAY

Edim D Bmin7 Emin7

A7 Emin7 Bmin7

Sophisticated Lady o (354

Quick lcons.
J= = * - Y BB...E&B.ME’....
ers achor [EVer] 75 b 4 74 MTD | WAI | MDL EDT CHD | VL+ | VI- | PLY | STP
$ b - h- o +

Obviously this function is only available for midifiles.
The image of the musical keyboard can be resized at will.
On the keyboard you can select the midi channels whose notes will be displayed
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Other Windows—> VISUAL METRONOME

By enabling this function, a VISUAL METRONOME is activated, suitable for drummers who want to

keep time but who want a visual reference instead of audio.

Winlive Pro 11.0

File View mode Tools Database Extra/Help Demo Songs Remote Support User: Promusicsoftware

g - Elapsed ‘T:(‘a»‘lﬁ Covlg;.t:lzgwn Signah‘"e C;lér:egt
v

NO ONE ELSE COULD LOVE YO

G#7(#9) GM7 Em7 Am7(9) D7(b9) GM7 Em7 E7 Am7 D7 GM7 F

(Instrumental)

C7(13) B7(b9) Em B/D# G/D

A/C#

Faug/Bb

w Quick lcons

Visual Metronome (midi) Delay: 180ms

This function is currently only possible for midifiles

It is possible to “calibrate” the display of the movements by clicking in the visual Metronome box

and pressing the right button of the mouse.

https://youtu.be/QoXKFH65T30?t=134
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https://youtu.be/QoXKFH65T30?t=134

YOUTUBE SONGS [CTRL + ALT + Y]

WARNING: please accept the conditions of YOUTUBE before using this service

We remind you that the YOUTUBE service, like all free services, is granted until the next version
of WINLIVE is released. It will be renewed only when upgrading your Winlive version once
delivered.

n This function is accessible through the YouTube button located on the other on the left, in
Performance mode.

Current Youtube audio device : Altoparlanti [Fecusrite USB Audia) Pawered by

import — Book  ALLOF ME-Frank Sinatra YouQ il

Search for Filter

Title or link Frank Sinatra VideoKaraoke Karaoke Al

'STAMDARDS & SHOWTUNES

ALL OF ME-Frank Sinatra From internal search

All The Way-Frank Sinatra From internal search

Besame Mucheo Ver Bossa-Frank Sinatra From internal search

|

am
= Blue Moon-Frank Sinatra From internal search

TLAE ADCRT NE”
AN WHEN | LODRED

tone, volurme or any nature. Search, playback an;

eptance of YOUTUBE'S TERMS OF SERVICE.

As you can see in the image, this function allows you to search and display on the screen the songs
present directly on YouTube through the search for the title and the artist.

This function requires an internet connection.

Within the function, a search filter is already set for the karaoke backing tracks, in addition to the
display, it is also possible to import them into a SongList of the database and enter the title, artist,
author, key.

To speed up and optimize the search, links from an internal list are recommended.
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Warning: It is not possible to modify the youtube song or download the song. Therefore,
transpose is also excluded, but it is only possible to import the link into the database and recall it
as if it were any song in our database. With the BOOK key we can book a song and start it after the
current one

Once the YouTube file has been launched, it is possible to remove an initial part (for example, to
skip an unwanted introduction) by right-clicking on Performance and selecting Insert YouTube
start point, inserting the seconds in order to start the song from the desired point.

YOUTUBE SONGSLIST [CTRL + ALT + L]

n Is a weekly uploaded section of links to YouTube songs. An internet connection is required,
as well as the acceptance of YouTube conditions.

This function is accessible through the YouTube button located on the other on the left, in
Performance mode
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METRODRUMMER [CTRL+ALT+B]

With the MetroDrummer you can use a real electronic drum with rhythmic patterns.

Metro Drummer X
F i PG dwn PG up

Midifile Style
Syncro Syncro I I

9 ] ‘ Perc Tempo- Tempo+

Jazz Ballad Ballrom Traditional World
Start/Stop Intro Standard = Variation @ FilltoStd = Fill to Var

Rhytm and
Country Dance Metronome \ 1 2 3 4 5

Latin Blues

The Metrodrummer can be used independently by reproducing the various rhythms (more than
220) with classic drum patterns, such as Intro, Standard, Variation and so on.

Very useful, for example, when you want to perform acoustic pieces with the need for a basic
rhythmic structure (keys: \ 123 45 6 and 7 for the various drum patterns)

The MetroDrummer can also be used as an electronic metronome for our classic teaching
exercises by pressing the METRONOME button

Furthermore, with MetroDrummer it is possible to synchronize our midifiles with the various
rhythms, for example to perform a MEDLEY live by playing the various midifiles that we will
perform at the same rhythm.

Click on MIDIFILE SYNCRO (key: 9) so that the first midifile and then all the other midifiles that we
want to play will start with the present rhythm while with STYLE SYNCRO (key: 0) it is the midifile
that synchronizes the rhythm of the MetroDrummer.
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Winlive Pro 14.0

File

Visualizzazione

Strumenti

I

Voice Name

(T

Real El.Bass
Clean Strat

(7]

(ol -1

Choir Aah Female
Oboe Sweet
Synth Strings 2
Trumpet Nat
Legato Strings Hype
10 Kit Real 5td 1

11 Winlive St.Piano
12 Synth Strings 1

132 El.Piano Pro

14 Dist Guitar St.1

15 Dist Guitar St.1

16 @_Dist Guitar 5t.1

a/a .

16:1

WL s

SETTINGS
Remix Style
Varl

Intro Var2

Retiming

Swin
Quantize <

WD
In

Midi cowver
Audio EFX
F¥1 Wocal Delay

FX2 Wocal

m Songlist1-1
L |

H 44 »»

Original style

Pop 16

Stile normale

Viol
127
126
114

114
127
127
126
127
127
126
126
127
126
126
127

100 36

Pre-Count

to End
Perc Fill in

Pop 8  Original

Gain W.Att.

Drrum
Part-Off
SN
HAT
OTH
PC2

=
BD
CRH

TOM
pCl

~

~ 1
~ 1

Songlists

*l

Other Controls = MIXER [X]

]
Potde
The Mixer window located on the left side of the
"Performance" screen allows you to keep under control
various parameters both midi and audio.

The 16 tracks of the midifile will be displayed on the
upper part.

In the first column VOICE NAME we will find the various
instruments that make up the midiifle

By clicking on the VOL (volume) column we could mute
the related track which will turn red.

The OUTPUTS column referrs to the midi output of the
related track and by clicking on it we could change the
midi output selecting one of the 16 midi channels

The DEVICE column referrs to the possibility of using
different midi devices.

The use of different midi devices is allowed if, for
example, a multiport midi interface or multiple midi
devices are used. To do this, in Options=>Midi 1, we
have to exclude the use of the WSE (winlive synth
engine). Therefore, it will not be possible to use
WINLIVE's internal sounds or sounds derived from
soundfont sf2, not in combination with external devices.
Also, to enable multiple external midi devices you will
have to select the function Allow multiple midi outputs
in Options>Midi 2
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Voice Name

*Real Ac.Bass
*Romantic Trumpet 2
Pan Flute Sweet

[V R TR R

*Tenor Sax V. 1
Legato Strings Hype
Legato Strings Hype
S *Hi Brass Full

10 *Funky Kit ICE

11 *MNatural Grand P.
12 *F.Clean Gtr 1

13 Trombone

14 Baritone MNatural

15 *0Orp. Rotary Perc.
16 *Hammond Rotary

s

=

(=]

o

SETTINGS

~

i Sty

Elapsed

Channel details 2
On - Off

Solo

All On

Channel blocked

Unblock all channels

Drum Editing
Llser Sounds Edit

(PC,MSB,LSE)

Restore all tracks

Click on an item to open a drop-down menu
and make a choice, among which it will be
possible:

CHANNEL DETAILS: a window will open
where various parameters relating to the
track in question will be displayed and, if
necessary, can be modified

The detail (in the mixer, click on the name of an instrument)

Voice Name

Real Ft.Bass
Winlive St.Piano
Real Vibes

Choir Aah Female
Synth Vox Pro
Warm Pad X
Palm Muted Guitar
Slow Orch Str.

Kit Real Std 1
Whistle Breath
Flute Natural
French Horns
Piccolo

Clean Strat

Palm Muted Guitar
4/4 Met

s0:0 K3

Original style

S0

O NN &BW N

72

78

SETTINGS
Remix Style

Intro Varl Var2 Perc

Volume
127
125
127
118
114

70
S0

124
64

100
113
101

94
Comp

Channel Manager
Device 2i2u
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE
- WSE

Devices

>>>

MidiVol : 125
Volume : 100%

Pan: 0

o Nl

30

Reverb :

Chorus :

to End

36,0.0

Fillin PC

Track 2 I

4
test

Sound Info (PC - MSB - LSB)

Altoparlanti (Scarlett |Real Ft.Bass

SB
J Normal Channel

Organ Guitar
Ensemble Brass

S.Lead S.Pad

Perc. Pure Efx
USER 1 USER 2 USER 3 USER 4
USER 5 USER 6 USER 7 USER 8
USER9 USER10 USER11 USER12

Timbre: Bl

CutOff: | I
|
|
I

Sound family select
Piano Chrom.

Bass Strings
Reed Pipe
S.Efx Ethnic

Solo

Attack :

Release :

Decay:

Restore B Channel not transposed

From this window it is possible to control in detail the functions of a track, choose the instrument
from a family of sounds, the Track, the Volume, the Pan, the Chorus, the Delay and Reverberation
(in case of expander), the Key (+/- 12 semitones), the activity and put it in "solo".

The "MFX synth engine" function allows the addition of an effect between distortions,

compressors, emphasis of

mids, highs and lows etc.

The abbreviation 'PC' identifies the transmitted Program Change number.
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It is possible to edit the sounds by varying different parameters (only works in the case of
expander):

- Stamp: increases or decreases the resonance;

- CutOff: increases or decreases the frequency cut;

- Attack / Release / Decay: regulates the envelope of the sound, according to the following
scheme:

INTENSITA —---semseeeemeo-

ATTACK  DECAY RELEASE
DURATA

The screen, in case of selection of Channel 10 / Drum, changes as follows:
Channel Manager Altoparlanti [Focusrite  [Kit Real Std 1 Tact

est
Vaice R v, vV, 0 o U58 Audio]
SR E oo S 2 ' Sound family select Drum Kit

- : = Track OUT Std. Kit Room Kit. Power Kit Elec. Kit
Real El.Bass 126 - - ; = he cFe K
Clean Strat 114 ON Solo 10 10 lazz Kit | Brush Kit Orchestra Sfx Kit

SN L7 Legacy FM-XG XG-Extra -
g;':"”;ﬂh F:male i;;‘ : Volume : 100% il e e e

DOE SWee 1 F, "

7 Synth Strings 2 127 - Pan : 0 ll USER5 USERG& WSER7 | USER &
# Trumpet Nat 126 g . USER 9 USER 10 USER 11 USER 12
9 L egato Strings Hype | 127 : Reverb: 25 Timbre: i

10 Kit Real 5td 1 127 Chorus: O '

Midivol : 127

11 Winlive 5t.Piano 126 - CutDff: I
12 Synth Strings 1 126 E pelay: © [l Attack - |
13 Fl.Piano Pro 127

14 Dist Guitar 5t.1 126 ; Key : i] ll Release : ] ]
15 Dist Guitar St.1 126 g Decay: ll
16 @ _Dist Guitar 5t.1 127 MFX synth engine

4/4 _a 0 No MFEX d

SETTINGS g1 : 4 Pre-Count

— Original style toEna | Sound Info (PC - MSB - LSB) Dyn : 1

Intro Varl Var2 Perc Fill in PC 1.0.0 Restore W Canale non tragposto

This will display the standard DrumKits instead of the sound families.

It is possible, if an external tone generator is used, to choose also non-standard DrumKit by
displaying the relative Program Change.

4 banks can be created with 8 sounds each; for each sound it is possible to edit the name, the
Program Change to be sent [0... 127], the Control Change value [0... 127] (it is possible to send the
CC # 0 and / or the CC # 32, refer to the manual expander) and finally all the various parameters
that characterize the sound.

For a preview, you can click in the box at the bottom left or press the left Ctrl key.

Once the bank has been created, it must be saved by clicking on the button é’j ‘

It is also possible to export sound banks to external files, and re-import them later.

This function is very useful if you use more than one external expander, as you can create several
customized sound files, one for each expander.
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ON-OFF: enable / disable the relative track

SOLO: solo it

ALL ON: reactivate all midi tracks.

CHANNEL LOCKED: the parameters of that track will not be modified even if we play a new
midifile. For example, if the selected channel has the Sax as an instrument and we block it, all the
midifiles we will play will have the same Sax with all the relative parameters

UNLOCK ALL CHANNELS: all locked channels are reactivated

DRUM EDITING: opens the window relating to the drum track

It is also possible to change the single sound of a drum using the Drum Editing function with
dynamic variations (% Dyn) for each sound

Drum Editing
Voice Name Vol Vo Outputs S
127 100 %
Real El.Bass 126 100 % From I‘:Jute To Mate

Clean Strat 114 100 % (B 1) Kick Drum 2 (B 1) Kick Drum 2
100 % (C 2) Kick Drum 1 21 Kic :
r Aah Female 114  100% R EL e By ]

Oboe Sweet 127 100 % (C# 2) Side Stick (C# 2) Side Stick

7 Synth Strings 2 127 100 % (D 2) Snare Drum 1

& Trumpet Nat 126 100 % .

9 Legato Strings Hype | 127 100 % (D# 2) Hand Clap H {D# 2) Hand Clap H
10 Kit Real 5td 1 127 100 % (E 2) Snare Drum 2
11 Winlive 5t.Piano 126 100 % -

12 Synth Strings 1 126 100 % (F# 2) Closed Hi-Hat (F# 2) Closed Hi-Hat
o) 127 100% | (A#2) Open Hi-Hat >  (A#2) Open HiHat >
14 Dist Guitar 5t.1 126 100 % ; -
15 Dist Guitar 5t.1 126 100 % (A# 2) Open Hi-Hat (D# 4) Open Hi Conga
16 @ Dist Guitar 5t.1 127 100 % (D 2) Snare Drum 1 (B 2) Mid Tom 1 R (E4) Lull.'-.r Conga
- b - (D 2) Hand Clap H (C# 3) Crash Cymbal (G 4) High Agogo
4/4 1&_ 0 (F 2) Low Tom 2 (F# 3) Tambourine (G# 4) Low Agogo

SETTINGS ap: 2 Pre-Count (F# 2) Closed Hi-Hat (G 3) Splash Cymbal (A# 4) Maracas

toEnd |(G 2) Low Tom 1 (G# 3) Cowbell (A# 5) Shaker
(G# 2) Pedal Hi-Hat (A 3) Crash Cymbal 2
Intro Varl War2 Perc Fillin (A 2) Mid Tom 2

Reset

(D 2) Snare Drum 1

(E 2) Snare Drum 2

CICICIC 1€ K [

<

Remix Style Original style

The maximum number of editable sounds is 8, and for each sound you can also edit the intensity
of the dynamic, and listen to them in preview by clicking on O

The window at the bottom will show the names of all the drum instruments used by the current
song, highlighting the modified ones in yellow. By clicking on reset you can restore the original
drum.
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USER SOUND EDIT: Here you can select and edit your own sound and save it. We remind you that
it is possible to save your own sounds in the 12 banks of 8 sounds each for a total of 96 user
sounds.

Sound Editor
Voice Name Vol  Vol%::Outputs | oo User sound 1
1 127 100 % BANK
2 |Real El.Bass 126  100% USER1 USER2 USER3 USER4 Program change PC
3 Clean Strat 114 100 % USER5 USERG USER7 USER 8 <mport g BANK CC# 0
4 100 % USER9 USER 10 USER 11 USER 12

5 Choir Aah Female 114  100% USER Sounds Export..  1SB BANK CC #32

6 Oboe Sweet 127 100 % User sound 1 a
7 Synth Strings 2 127 100 % TE— Sound Editar
& Trumpet Nat 126 100 % User so ;
ser sound 3 . .
9 Legato Strings Hype | 127 100 % e L Timbre: ]

10 Kit Real Std 1 127 100% User sound 4 CUtOff: ]

Save —» KA

1 Winlive 5t.Piano 126 100 % User sound 5

12 synth Strings 1 126 100 % User sound 6 Attack : ll
13 El.Piano Pro 127 100 % User sound 7

14 Dist Guitar St.1 126  100% TI— Release : 1}
15 Dist Guitar St.1 126 100 % D S

16 @ Dist Guitar 5t.1 127 100 % TEST  [LEFT CTRL] Lo | |

a4fa ..a 0 Mod: II
SETTINGS 992 : 2 Pre-Count Dyn Maod Fa: II
Remix Style Original style to End
—  m————————————
Intro Varl Var2 Perc Fill in

(PC, MSB, LSB): the instruments of the 16 tracks will be displayed with the indication of the
Program change (PC), Bank Select Most Significant Byte (MSB) and Bank Select Least Significant
Byte (LSB).

We recommend these functions to users more experienced in the knowledge of the MIDI protocol.

RESET ALL TRACKS: with this function, all changes made will be canceled and you will return to
resetting the sounds and functions of all the tracks.

A little further down we will find the following image:

| Y = =

Pre-Count

SETTINGS | 0:0

The SETTING button will open the WSE SETTING (Winlive Synth Engine) screen to set all the
general parameters of the Winlive internal SYNTH (see paragraph in the TOOLS chapter)

Alongside we find the tempo signature and the relative beats.

You can enable / disable a metronome by clicking on the corresponding button.

With the PRE-COUNT it will be possible to set the initial measures for each midifile

The following two padlocks are respectively for blocking the midi channels and the midi output
devices for each midi file

Through the REMIX STYLE it is possible to change the style of the song, choosing between the
various styles and being able to apply 2 types of variation and the use of percussion, the intro and
the end of the style. This is obviously valid only for midi file.

With RETIMING QUANTIZE you have the option of using a different quantization according to the
rhythm you choose.
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- ===== ELLA  AUDIO SECTION
EQUALIZER o u

i Lo el In the Audio section we find the Volume Fader to

Peals — adjust the level of the output audio, the three faders
B K for equalizing the sound, Gain adjusts the gain of the
EEE = '

audio backing track, the V.Att fader regulates the
attenuation of the voice. For the first three, it is
possible to secure them for all audio bases by locking
the relevant lock. At least Pan and right and left
channel management for MPX files

Audio EFX

Audio EFX adjust the volume of the effects selected in
F¥X1 Vocal Delay

the drop-down menu in the corresponding box of the

FX2 Vocal second track;

] The MIDI section features a volume fader to increase or
[ﬁl][]"]] = = | PE;E_’E,, decrease the same (with the lock closed all the midi
n BD SN songs will play at the same volume), and the faders to
BN Bm  CRHHAT dose the Reverb and Chorus level of the midi song.
B B oM O The Drum Part Off section allows you to exclude the
PCL | PC2 sounds of the drum parts, allowing you to individually
choose each part of the drum to be excluded and with
the padlock closed this setting will be valid for all
midifiles. The Midi Cover function allows you to choose one of the preset registers in order to vary
the instruments suitable for the selected style.

Midi cover Stile normale “r m

Iﬂ We remind you that all the changes described above can be saved virtually and then
stored in the database by clicking on the QUICK SAVE button [CTRL+S]
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Other Controls = VISUAL MIXER [CTRL+X]
Displays a mixer horizontally with which we can control the various tracks of the midifiles or of the
audio multitrack songs

Bbmin7 Fmin7

YOU AND I

Ebmin7 Eb7 C7

C#min7

w Songlist2-2 w Quick lcons

P E

Other Controls > MELODY BAR [E]

It is activated and deactivated via the "View" menu -> Melody Bar or by pressing the MDB quick
command or by using the letter key [E]. We strongly recommend how we will reiterate the use of
the PC keyboard keys instead of the mouse several times. With a single press the screen, like the
one below, will be displayed, describing chords and melody notes. Obviously this only for midifiles

= ‘ E= -.“p_zj-j-:-fi’)j

o TAUANI- 1 18 Vasco Rossi - Come Stai (live) 19 Sergio Caputo - Bimba se sapessi (iive) JJIFF) (Y5

st
r Quick icons
- Ll 4 10 Fa Jf T e * Bmmamaummmama
T h 4 -

L] o+
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In addition, by clicking on the settings function (bottom right) we can change parameters for
displaying MELODY BARs such as displaying guitar chords.

G#Maij7 G#7 Bbmin7 Ebmin7

ettiny
4
0 +

soufss

A second press allows you to view only the graphics of the trend and the timing of the melody
(track 4 in the case of midi, based on the text in the case of the mp3), in order to help the singer to
go to time with the song. This feature is highly appreciated especially for Karaoke performances.

o MALANI-1 a i (1 1gio Caputo - Bi ssi (i
d - Ll N 1 — * BBMEE@EBE
[ r 0+

The lines showing us the melody can be vertical (as in the picture) or horizontal.

You can set the fixed or sliding melody bar (see chapter Options).

If it were set fixed, the page change would take place in correspondence of the red line (generally
every 40 seconds).
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Other Controls = CHORD BAR [C]

It is activated through the menu "View mode" -> "Chord Bar" or by pressing the Quick Icon CHD or
through the letter key [C]. View the chords (if any), scrolling them simultaneously with the song.
As for the midifiles WINLIVE allows the calculation of the chords in real time or to view the chords
written within the midi file

For audio files, it allows the display of chords only if they are written within the audio file.

Recall that the chords can be viewed both in Standard notation (A, B, C, D, etc.) or in Italian
notation (Do, Re, Mi, etc.)

The related chords options can be found in Tools—>Options—> Chords and text

Winlive Pro 14,0

LET ME TRY AGAIN -

AND I'VE

COME BACK TO STAY
LET ME TRY AGAIN LET ME TRY AGAIN

LET METRY . -!!m n ; ¥ Quick lcons
Lintr i 78 * D il o * BB@EBEB@@B
Ginte. Chor £ -0 +

4.Chor 5.Vers J=
13
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In addition to the Chord Bar, you can view the chords directly on the text by clicking with the right
mouse button on the main screen -> “Karaoke mode (main)” -> “Reading desk with Chords”.

‘Winlive Pro 14.0
..... atabase a/Help __Demo S emote Suppol ser: Promusicsoftware () - B X

-I_IEHE[E] i s'g'“l i1 : LET ME TRY AGAIN -

PLEASE LET ME TRY AGAIN

(Instrumental)

C7 Dmin7 F  FMa

I WAS SUCH A FOOL TO DOUBT YOU

Dmin Dmin7 Amin

Gmin7 FMaj7

LET ME TRY AGAIN MY WAY n 8

4
s * BE&EME
0 +

And finally you can also view the scrolling chords in the Melody Bar by selecting "SHOW ONLY
CHORDS” in setting

Winlive Pro 14.0

$ER = 8 X

‘View mode Tools Databas Extra/Help Det

ongs
-- Emm@ Elapsed Total I CountDown sngna( ent
00:43  04:3 -04:27 /

") 1S NEAR

AND SO I FACE, THE FINAL CURTAIN

Emin Emin7

Bmin: min7 Gmin min: Bmin? B7 A7 A
D 07 Edim A7 DMaj7 Emin Bmin7
Emin? F#min Emin7

min
#dim A7 F#min7 GMaj7 Bmin7 D F#dim G DMaj7
2 o2 e e way T T
:

Sophisticated Lady

Other Controls - CHORD BAR IN THE KARAOKE MONITOR [SHIFT+C]
With this function you can also view the chords in the karaoke monitor very useful function
especially for bands who want to view the chords in a second monitor.

33



Other Controls - SAMPLE PLAYER [S]
SMP
s

By pressing the button you can access the Sample Player or by pressing the [S] key

Image / Text / Sampler Bank Bank1l Bank2? Bank3 Bank4 Bank5 Bank6 Bank7 Bank& Bank® Bank10 ResetAll >>Download Samples<<

With this function, it is possible to reproduce quickly, even during the execution of a song, sound
effects, images, pdf, texts or Audio Loops.

It is possible to have 10 Banks of 10 Samples each, for a total of 100 samples.

To upload the samples, click on the box next to each sample (when no sample is loaded, “No file
Loaded” appears) and choose the file from the dialog.

For each sample, you can adjust the volume. You can play the samples in Polyphony, or, by
checking the Mono option, play them in Monophony (i.e. if one sample is running, and another is
recalled, the running sample is terminated).

The Comp option allows, if checked, to activate a general compressor on the samples, that
automatically uniforms their volume.

With Fade selected, it is possible to fade when the sound effect ends.

During the Performance, it is possible to access the sampler just pressing the [S] key, and then
pressing keys [1] to [0] on the keyboard. To stop the reproduction of the samples in a forced way,
press the [\] key.

It is possible to download additional audio samples by clicking on Download Samples
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Other Controls = WINLIVE DJ CONTROL [CTRL+ALT+J]

Section with typical Djs mode with BPM recognition for Audio files, effects in real time and several
tools available. Allows you to perform both manual and automatic mixes

Current Song = ::‘D ErxJ
5 la-res|
SR 55> TEMPO SYNC >>> M 1 Vifiters)

ok
Umberto Tozzi - Gli 0z2i - Raf - Cosa »

AUTOMIX  MANUAL MIX

Mix Type: Quick ﬂ’?\
R vy Y Auto Wit i

winlhived

To perform the Automatic mix with the first track in play and the second one booked, just click
first on Tempo Sync and then on Auto mix, in this way Winlive DJ will automatically switch from
one track to another.

In order to mix manually, so with the first track in play and the second one booked, just click first
on Tempo sync and then on Manual mix. In this case, you will find a writing in red (Mix 2%). Click

on it to advance the mixing percentage and gradually switch from one track to another.

In addition to the various ways of mixing, the Winlive DJ also allows you to insert effects such as
Reverse Play, auto WHA and Phaser that can be used through the pad on the right.
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Other Controls - SUBTITLE KARAOKE MONITOR

Subtitles / Karaoke monitors

azz Piano Trio - Jennifer Vocalist

Update text

Disable

Text Color - =
[ | 10

=

This setting allows you to insert a sliding subtitle at the bottom of the karaoke monitor allowing
you to set the colour, font, background, size and speed of passage of the subtitle.
It is useful when you want to launch messages to the public in combination with karaoke is

playing.

mote Support User: Promusicsoftware [} - & X
MY WAY -

I PLANNED EACH CHARTED COURSE
EACH CAREFUL STEP ALONG THE BYWAY
AND MORE, MUCH MORE THAN THIS

I DID IT MY WAY

DMaj7
I PLANNED EACH C

YES, THERE WERE TIMES
Jazz Piano Trio - Jennifer Vocalist

D Bmin7 Emin7

nglists. MY WAY Sophisticated Lady ) (3154

=iz
J= T * Bmama&@a
Hh- 0 +
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Other Controls = WINLIVE DIGITAL PIANO [CTRL+ALT+W]

It is possible to use the sounds of WINLIVE PRO SYNTH 14 to play with an external midi keyboard.
With a low latency sound card it will be possible to play as a powerful 4-part synth with which we
could have fun playing or creating COMBI using the internal sounds of the Winlive.

Close a = < 000Winlive Grand Piano B MIDI ALL -~ STORE COPY .Import Export..

Midi Out KeyRange DynRange Voice Name Reset Combi Vol Key Det Pan Rev Cho Res Cut Atk
e [CA ae [G9) ~- o Winlive 5t.Piano 0 o0 0o 0

Winlive St.Piano
Winlive St.Piano

[T ar

~

I oae [ a e o 27 Winlive St.Piano
~r
~r

wr (G~ (53]

Volume 127 Delay © II

First we need to select the midi keyboard driver via MIDI INPUT in MIDI OPTIONS 1. We can use
the 128 COMBIs, most of which are already configured while for the others we can create and save
them. We can associate a different COMBI for each SONG or with the padlock closed we can select
it for all the songs that we will play midi, audio or video.
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Notepad Cls u O «fF

X

write your notes herE|

Other Controls = CLIPBOARD WINDOWS [CTRL+N]

It allows you to view a small Notepad in various
formats where you can write notes during your
performances. By clicking on CLS you can delete the
entire contents of the Notepad. We can also select
the size of the clipboard window by simply clicking
one of the three dimensions.

Also you can, enlarge or shrink the font.
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Tools menu

OPTIONS

In this function and in the submenus you can customize the program according to your needs. We
remind you that WINLIVE, leader in its category for 30 years, has collected the requests and
listened to the needs of thousands of musicians and singers all over the world so as to be able to
adapt the program in a personalized way. (see paragraph)

Editor = SONGLIST EDITOR
You can access the SongList Editor by the Tools menu = Editor = Song list editor or, im
performance mode, by clicking on the bottom left next to the name of the SonglList.

Stop - Mel.Off - Order Stop - Mel.Off - Order
(total) CONTROL+ SONG LIST

(0) Songlist21

(D) Songlist 22

[0} |Songlist 23

[0) songlist 24

(0} Songlist 25

(D) Songlist 26

[0) Songlist 27

[0) songlist 28

[0} Songlist 29

[0) songlist 30

(total) NORMAL SONG LIST
[76) MY SONGS
(0) |DUET

(0) | DAMCE

(0) LATIN

(0) |Songlist5
(0) |SongList 6
(0} SongList 7
(0) songlist8
(0} SongList 9
(0)

NAME SongList F1.F9 NAME Ctrl + F1.F10

DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT

DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT

EEEEEEEEEEA
EEEEEEENEEEQR
CLCIC IS K G

EEEEEENEENNQA
EEEEEENEENENR

CORKKKCAK K

Stop - Mel.Off - Order Stop - Mel.OFf - Order
(total) SHIFT+CONTROL+ SONG LIST
(o) Songlist 31
(o) SonglList 32
[0) songList 33
[0) songlist 34
(o) Songlist 35
(o) Songlist 36
[0) songlist 37
(0)  Songlist 38
[0) songlist 39
[0)  songlist 40

(total) SHIFT+ SONG LIST
(0} SongList 11
(0} songlist 12
(0} Songlist 13
(0) songlist 14
(0} Songlist 15
(0} Songlist 16
(0} Songlist 17
(0) songlist 18
[0} songlist 19
(0) songlist 20

DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT

DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT
DEFAULT

EEEEEEEEEEA
EEEEEEEEEEA
L0 CIC I C LK
EEEEEEEEEEA
EEEEEEEEEERA
CJCIC L LK

NAME Shift + F1.F10 NAME Shift + Ctrl F1.F10

DEFAULT ORDER TITLE
Cancel

In order from the left we will find:

- the corresponding key to recall the Songlist;

- the number of songs in each Songlist:

- the name of the Songlists

- by ticking the STOP box, the set list will stop playing, while not ticking it allows continuous play;
- by ticking the MELODY box, each song in the list will be played without the melodic guide
(midifile);

- the ORDER function provides a drop-down menu from which you can select the order mode in
which songs will be played (if we indicate TITLE, for example, we will have an alphabetical order,
rather than by ID, by interpreter, by author and so on).

DEFAULT ORDER: here we can select a general order as long as there is no specific order in the
SonglList.

= https://youtu.be/y5ESpEAKWag
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https://youtu.be/y5E5pEAKWag

Editor = MIXING EDITOR
Mixing Editor can be accessed via "Tools" menu—> Editor
Mixing Editor

Mixing custom presets

Quick

With the mixing editor, you can set the progress and duration (in milliseconds) of the Cross-Fade,
i.e. the mixing of two songs. We remind you that mixing between 2 midifiles is not possible. In this
case we will pass from the first to the second song, by fade out and not mixing

The green line indicates the ending song, while the red line indicates the song that will be merged
together with the first one.

By default, Winlive will adopt a linear type behaviour, with a progressive and constant lowering of

the volume of the song to fade, simultaneously with a progressive and constant increase of the
volume of the following one. You can select five pre-set curves, or draw a custom curve.
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Editor > SOUND BANK EDITOR
By clicking on “Sound bank editor” it is possible to use new sound banks.

Usa banco MISB CC #0  Usa banco LSB CC #32
B

[
o
|
o

L 0 N N s W N

L el o o
W N e

[
(%))
H H Bl EEEEE NN BEN

OO0 0 0 000000 00 O 0 O
CIC|QC|OC|OC|OQC|OC|OC|OC|OC|C|O|OC|QC]|O
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Editor = VOICE LIST EDITOR
In this function it will be possible to create a sound list with reference to your connected sound
module. These sound lists can be saved and then loaded if necessary.

Voice List Editor

Sound family select
Piano Chrom. Organ Guitar Bass Strings Ensemble Brass
Reed Pipe S.Lead S.Pad S.Efx Ethnic Perc. Pure Efx DRUM KIT

Instrument Name Program PCG CC#00 MsSB CC# 32 LSB
Upright Jazz Piano
Bright Up. Piano
El. Grand 2

Honky Man

E. Piano 1

E. Piano 2

St. HarpsiChord
Clavi 2

Classic St. Piano

s N B W N e
[
Q0 00 QC QO Q0 Q0

=import

<Export
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Editor > DRUM KIT USER
By clicking on "User drum kit" the screen changes as follows:

User

User drumkit selecor TEST [Left Ctri]

lﬂ Export Kit | Import Kit Reset Kit

Patch | Kit Real Std 1 ﬂ Name User Kit 1 1sB 0 Apply  |Reset Note

Note Drum Note Sound Rev (add) Cho (add) Cutff
(B 1) Kick Drum 2 (B 1) Kick Drum 2 100
(C 2) Kick Drum 1 (C 2) Kick Drum 1 100
(C# 2) Side Stick (C# 2) Side Stick 100
{D 2) Snare Drum 1 (D 2) Snare Drum 1 100
(D# 2) Hand Clap H (D# 2) Hand Clap H 100
(E 2) Snare Drum 2 (E 2) Snare Drum 2 100
(F 2) Low Tom 2 (F 2) Low Tom 2 100
(F# 2) Closed Hi-Hat (F# 2) Closed Hi-Hat 100
(G2) LowTom 1 (G2)lowTom 1 100
(G# 2) Pedal Hi-Hat (G# 2) Pedal Hi-Hat 100
(A 2) Mid Tom 2 (A 2) Mid Tom 2 100
(A# 2) Open Hi-Hat (A# 2) Open Hi-Hat 100
(B 2) Mid Tom 1 R (B 2) Mid Tom 1R 100
(C 3) High Tom 2 (C 3) High Tom 2 100
(C# 3) Crash Cymbal (C# 3) Crash Cymbal 100
(D 3) High Tom 1 (D 3) High Tom 1 100
(D# 3) Ride Cymbal (D# 3) Ride Cymbal 100
(E 3) Chinese Cymbal (E 3) Chinese Cymbal 100
(F 3) Ride Bell (F 3) Ride Bell 100
(F# 3) Tambourine (F# 3) Tambourine 100
(G 3) Splash Cymbal (G 3) Splash Cymbal 100
(G# 3) Cowbell (G# 3) Cowbell 100
(A 3) Crash Cymbal 2 (A 3) Crash Cymbal 2 100
(A# 3) Vibra-Slap (A# 3) Vibra-Slap 100
(B 3) Ride Cymbal 2 (B 3) Ride Cymbal 2 100
(C 4) High Bongo (C 4) High Bongo 100
(C# 4) Low Bongo (C# 4) Low Bongo 100
(D 4) Mute Hi Conea D 4) Mute Hi Conga 100

Dyn

RE2R2BTER2R2R222R22R2R2222R2RRER
Pococoocoocoococoocoocoocoocoocooooooooo
boococcococococococcococoocoocoocoooosooes
REX2RR2RE2R2T2 2222222 RER
RE2RBTRE2ZB222R2 222222 eeeee

Where you can configure your own custom drum kit.
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Editor = QUICK ICONS

w Cuick lcons

In the right part of the bar you can see several coloured buttons which allow the quick access to
several functions and modes::
(We remind that these quick buttons may not be viewed if the resolution of the monitor isn’t right
as for notebook with little monitors)

e PRF: Quick button to come back to Performance mode

e EXP: Quick button to enter in Media Explorer mode

e MTD: Quick button to enter in Metrodrummer (Virtual Drum Machine)

e WAI: Quick button for accessing the WINLIVE Al Audio processor extra service

e MDL: Quick button for the access to Medley Creator

e BKT: Quick button for the access to Background Songs

e KMN: Access to Karaoke Monitor

e DBS: Access to Database

e EDT: Access to Edit Mode

e MDB: Opening Melody Bar

e PNO: Opening Piano Key Board

e CHD: Opening Chord Bar

e VL+: Volume (up)

e VL-: Volume (down)

e PLY: Play

e STP: Stop

It is possible to edit Quick Icons and to assign to everyone some specific functions
Quick Icons Editor

Function Assigned to :

Performance mode Reset-Default

Description ‘

Performance

44



Editor > WINLIVE SOUND REMAPPING

In this function we can remap our sound library according to our needs. For example, we can swap
the instrument of the first column with that of the second in order to create our customized sound
list

Suonoy/Pr uonofProgram Sostitutivo
0-0 Winlive 5t.Piano Natural Grand P

1-0 Winli 1-64 Natural Grand Br.

4-0 El.Piano Pre 4-55 Nat. Wet El.Piano

i Org

Hammo

o m

¥

Master

[ R R R
tn [y

PRLTPRPRRLYP

F.Clean Gtr 1
Muted Elec Guitar

g

Bora R R DO R R Ra

Timpani Real
nth Strings

nth Strings

Trumpet Nat

Muted Trp Vib.
0 Tenor i

Flute

Chiffer Lead

5t.Fm Fantasi

)
Warm Pad Plk

B4
B4
B4

-64

5
B4
G4

-Bi

54

S5
a

n g

- >
Instruments Mode Drumkits Mode s y Import  Export
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Utility = FILE TRANSFER
By clicking on this item we can transfer all the data present from the c: \ Program Files folder to
the Documents folder thus obtaining unrestricted access.

Utility > OPEN FOLDER WINLIVE DOCUMENTS
This utility will allow us to locate and directly open the Documents folder where Winlive files will
be present.

Utility > OPEN VIRTUAL FOLDERS AND STORE
Windows creates hidden folders where Winlive in previous versions stored important files such as
the database. To access these particular folders directly click on this function..

Utility > START WINLIVE CD PLAYER / EXTRACT
WICD =]

Track 1
Track 2
0 03 Track 3
00:05:32 Track 4
00:01:20 Track &
o 50 Track 6
Track 7

Eject Clozse » 1

Track 1 0
Track 1 /11 Tempo 100%  Pitc
- . v i -

With this function, it is possible to extract tracks from Audio CDs and save them in Wav or Mp3
format.

It is necessary to select them (you can select them all through the "All" button or select them
manually by clicking on the first column), then click on the Convert button.

You can choose between uncompressed Wav (Wave not compressed) and Mp3, varying the
quality according to your needs (eg "Minimal Only for voice store" generates a low quality file with
the smallest footprint on disk, while "Maximum quality” generates a high quality file, but also with
the largest disk size).

The peculiarity of this CD player is that it has the advanced features of commercial DJ CD
players, that is, it allows you to change the tempo and intonation (Key) in real-time.
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Utility > GUITAR TUNER
The guitar tuner could not be missing to make happy guitarists and other musicians.

Sustain - Dyn  Transp

i
s | ®

io
Io
lo

e

v
g
° °
©

Midi Instrument
Nylon Concert Gtr. ~ OK ‘

We can choose the tuner sound, the length of the sound (sustain), the dynamics (Dyn) and the
Transpose.

Utility > CONVERT LYRICS IN LYRICS3 FORMAT
This function allows you to convert the text of an mp3 into Lyrics3 format compatible with some
systems capable of displaying the text line by line (for example Ketron Midijay and others).
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WINLIVE Al Audio processor (paid service)

This service, which can be purchased by subscription, allows you to analyze an audio or video track
and split it into several tracks.

Accept the terms and conditions before continuing.

(no song loaded)
Load song

P H <« »» _

Single track: No_Vocal

Process tracks Abort

At the top are the
daily minutes and the expiration date of the service.

The minutes to be scaled are given by the duration of the track to be processed. For example, an
audio song of 3 minutes and 40 seconds will scale our daily count by only 3 minutes.

By Load Song we load the song we want to process.

The buttons below allow us to put it on play, stop or go backward or forward.

With the drop-down menu we can choose which function we want to use:

- Single track: no vocal: saves to an audio file excluding the vocal track.

- 2 tracks: Vocal/Music: saves in *.Zip format or in *.wmt format (Winlive multitracks) the two
separate tracks (vocal and music part)

- 4 tracks: Vocal/Drum/Bass/Other: saves in *.Zip format or in *.wmt format (Winlive multitracks)
the 4 separate tracks (vocals, drums, bass and other parts)

- 6 tracks: Vocal/Drum/Bass/Other/piano/guitar: saves in *.Zip format or in *.wmt format (Winlive
multitracks) the 6 separate tracks (vocals, drums, bass, guitar, piano and other parts)

Clicking Process tracks starts the operation.

For video files only the first function can be used (single track: no vocal) thus obtaining a video file
without the vocal part.

The processing is done on high-performance servers equipped with artificial intelligence (Al)
algorithms so an Internet connection is required for these operations.

The artificial intelligence algorithms are self-learning, which means they become increasingly
accurate over time.

https://youtu.be/jxj4CbN-tNc
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MEDLEY CREATOR

In this screen you can combine up to 6 audio tracks (mp3 or wave) to create real medleys. If we
also want to use midi or video files, however, we must first convert them to audio using the
relevant functions within Winlive Pro Synth 14

Medley creator
File

Use Mouse Left Click to select an Area, Right click to seek sound

1

Zoom  Full
Start End

AUDIO TRACK : 6 Basi musicali - Albano E Romina - Felicit-....mp3 Fade IN (ms)

Fade OUT [ms)
Remave Set | - Set - II
130300 151611

Load File Test Start Test End L I

Mix Current Time Total time a B
L} -
0 4:09:648 Save in WAVE = Sawve in MP3

To load the first track, we click on the 1 button followed by Load file, where we can select the first
track of our medley. We repeat the same procedure to load up to 6 tracks, remembering to click
each time on the number corresponding to track 1 through 6.

To select the desired portion of the track, let us position ourselves on the starting point and left-
click, dragging to the right to highlight the area of interest.

The same operation, and more precisely, can be done using the buttons at the bottom.

We click SET of the START section and then SET of the END section so as to establish, by ear, the
start and end points of our selection. We can adjust the START and END points using the (-) and (+)
buttons and test them with TEST START and TEST END. For each song we can graphically enlarge
the start (START) and end (END) part or whole with FULL.

With FADE IN and FADE OUT we can gradually raise or lower the input and output volume of the
highlighted portion of the song.

If the selected tracks have different volumes, we can enter a percentage value and then click on
GAIN to equalize the volumes of the different tracks.

With the PITCH button we can change the pitch of the selected song.
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UNDO cancels the last operation.

Finally, by selecting the first track of our medley and pressing the TEST button at the bottom left,
we can listen to the final medley and decide whether to save it in WAVE or MP3 format, selecting
the various resolutions for the latter.

If we want to save our project, perhaps to edit it later, we can click on FILE at the top and then
save or load an existing project.

Finally, remember that saving our medley will preserve lyrics and chords present in the various
songs. In addition, markers will be inserted at the tracks in question.

https://youtu.be/2fjdmpQt3kw
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REMOTE CONTROL

The main functions of the Winlive can be remotely controlled via our APP available for both
Android and iOS. Additionally you can view the lyrics on our mobile device.

Totally free apps will be downloaded from:

for iphone or ipad:

https://apps.apple.com/it/app/winlive-remote-control/id1584198937

for Android systems:
https://play.google.com/store/apps/details?id=com.promusicsoftware.WinliveRemoteControl
A necessary condition is that both the PC and the mobile device are on the same network. An
internet connection is not required.

By clicking on Remote Control, a screen will appear that will indicate the IP address of our PC.

& Winlive Remote Control

Resize Window |§

inlive IP Address:
192.168.1.112

Open the APP on our mobile device and enter the same IP address as our PC.

If we accept the connection, a message will appear where we can set the APP as MASTER or
SLAVE.

MASTER means that from our smartphone or tablet we can control our PC. If we decide to enable
it as a SLAVE we can only view the texts included in the midi, mp3 and mp3-cdg files.

https://youtu.be/FiQbEjvVtTO

51



VIDEORECORDER
In addition to the automatic saving in Video from the FILE menu we can record a video by
capturing it directly from our screen. Clicking on this function will open the following screen

S Winlive Capture v12.0125 - B
Capture...
Output Filename... Video Format
C:\Users\Leonardo\Documents\WinlivePro\EXPORTED SONGS\Capture01_[] mp4
Area
Custom Area m.: select area
Video Size

Use Window/Area/Desktop Size

Audio Device

Missaggio stereo (Realtek High Definition Audio)

Logo Overlay...

Image

-

Opacity Position

Transparent

OUTPUT FILENAME: We can decide what name to give to the file and where to save it
VIDEO FORMAT: select the type of file to save (mp4 or avi)
AREA: the area involved in the video saving is indicated.
CUSTOM AREA: click on select area to select the size of the area
WINLIVE PRO 12.0: select the area corresponding to the main Winlive window
KARAOKE MONITOR: select the area corresponding to the karaoke monitor
MONTOR O0: selects the entire area corresponding to the main monitor
MONTOR 1: select the entire area corresponding to the Secondary monitor (if present)
VIDEO SIZE: determines the resolution of the video format
LOGO OVERLAY: here we can decide whether to superimpose one of our images on the video and
decide both the position and the opacity
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SONG PERFORMED (List of songs played)

Each song played both in Performance mode and when executed on the fly is stored by Winlive.
You can then save this list in a text file.

The title of the piece performed and its author are both given. In case of missing information, the
interpreter is given (marked with an asterisk).

Select Tools -> Song Performed" menu; the following window will be displayed:

Song Played List (HISTORY)

B Always on top
SIAE LIST (Date)05/03/2024 [Time)08:15:27

8:16:58 - No auth. Joy To The World Reset Open
8:17:01 - No auth. O sole mio

8:17:04 - No auth. Guantanamera|
B:17:06 - No auth. House Of The Rising Sun

Save when closing the program

*Artist

LA DL DPLTLIUT B LIPS TS U DT )

s

C:\Users\PMS\Documents\WinlivePro\HISTORY\05_03_2024_ 08_15_ 20.txt

File :

All lists are stored in the \ HISTORY folder, which can be viewed in WinlivePro in documents.
The RESET button allows you to delete all the contents of the list.

CLOSE closes the function.

With the OPEN search key, it is possible to search for the location of the lists.

The drop-down menu allows you to select when to save the list:

1 - each time the program is closed;

2 - at the end of each song.
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PHYSICAL SAVING OF SONG
It is also accessed by clicking on File -> Save File

Real Ac.Bass

lazz Semi

> 0 00 s N LN s L P e

[
[Ty Ay

Kit Real Std 1

[y

1

Clean Strat

o
T

Save in MIDI

A E8 ) £ B C) L4 B8 ) LA R4 R4 A

M| *Clean E. Guitar

M Click - Metronome
ia

| | L1 |
Save in WAVE | Wave ALL F10
MIDI chord saving format

Std. Winlive/Solton MEV#FF-05(%) A

Save in MP3
C:\Program Files (x86)\WinLivePRO\demosongsiLa Bamba.mid
B Allow overwriting of original file

Y
-

Save in VIDED

With this feature it is possible to physically save the changes made to the Midi, Audio or Video
files.

By ticking the "Save from first note" option, you can cut any seconds of silence that may be
present at the beginning of a song.

The "Output" column allows you to change channels for each individual track.

Example: in some songs the vocal melody track is not saved on channel 4 (as foreseen in the
standards) but in other channels, for example on channel 1. To invert the tracks it will be sufficient
to write “4” in correspondence with channel 1, and "1" at channel 4.

The "Track" column allows you to save or not the track

The "Instrument" column indicates a changed instrument and saves it.

The "Vol" column indicates any volume changes made (100 = 100% of the original volume).

The "Dyn" column indicates any dynamic changes made

The "Fixed Vol." Column sets a save value for the midi volume

You can also choose to include the Karaoke text or Chords in the file.

The "Add seconds to end" box allows you to add a number of seconds to the end of a song.You can
choose the track to edit, and the possibility to include the text and chords.
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With the key changes are virtually saved to the database, while the keys

et are used to effectively save midifiles and to save all the songs present
in F10 in midi format.

LN keys you can change the file format from Midi to Wave or
convert all the songs in F10 into Wave format.

With the EELE ;:VAVE

The key Save in MP3 @l allows you to transform a midi file into MP3 format with the
possibility to choose the sound quality of the file by pressing the arrow key.

Note: you can save mp3s both virtually and physically

By selecting the function Save splitted tracks (multitrack) we will have the possibility to save in
multitrack midi if we save a midi or if we transform a midi into audio we could save as many audio
tracks as there are original midi tracks
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If we choose to save from MIDI or AUDIO to VIDEO we could choose various parameters and save
in Avi or Mp4 format

Save File H

7]
=¥]
=
D
=
=
)
=]
=

m

[=

[T

8 =i BN L s

& 2
L1} L]
Save in MIDI MIDI ALL F10

|

Click - Metronome
ia f=-1
L[ | |1 |
Save in WAVE | Wave ALL F10
MIDI chord saving format
SHd. Winlive fSnlton MPUSEE-N5125) s Fa Y
Input Window Size * Hi Cpu Required Speed and FPS
1024 x 600 WSVGA [default) ~ @ 'ostencoder 20fps 3x (default)
[big file size)
Audio Sync: 0 Output Size and Format

H264 Use input size (safe and fast)
I“ ® b4

Use settings for
R XVID

-— minimum g e Good I?'].Eik] ‘
Save in VIDEOD requirements (AVT) Close

E https://youtu.be/Fx1Y9TVAVIc?t=305
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https://youtu.be/Fx1Y9TVAVIc?t=305

GENERATE SONGBOOK (Lyrics and chords)
By selecting this function you can view the lyrics and chords contained in a song (midifile or audio)
6 Generate Songbook (lyrics and chords) : Joy To The World — O *

5_ - Font SIZE Interline SIZE Orientation Chord separator  Chord color  Lyrics color  Title color
RiE I PR! 16

~ 10 ~ Chords above ~~ ~ I:I |:I |:I
Joy To The World ()

D F#min7 Bmin7 A7 F#min7 A A7 D
JOY TO THE WORLD

Emin7 Bmin7 F#min7 Bmin7
Joy to the world! The Lord is come!

Emin7 A7 D Bmin
Let earth receive her King!

Bmin7 D
Let every heart prepare Him room,

Bmin7 D
And heav'n and nature sing,

Bmin7 F#7
and heav'n and nature sing,

BMaj7 Bmin7
and heav'n and nature sing,

D
and heav'n and heav'n

DMaj7 Bmin7
There are various options for a customized view. It is possible to save in RTF or CHORDPRO format
and then print it.

SONGBOOK MODE SETTING

To change the various parameters (font, text color, chord colors, etc.) go to TOOLS—> and click on
SONGBOOK MODE SETTINGS

4 Songbook Options - [} *

Font SIZE Interline SIZE Orientation Chord color  Lyrics color Filling Backg color

16 ~ 10 ~ Chords above ~r I:I I:I I:I - Ap’:i;ly ‘
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SYNCHRONIZATION OF LYRICS / CHORDS
With this feature it is possible to add lyrics and chords to Midi, Audio and Video files.
As for the video, it is not possible to overlay it but at the upper edge of the video.

Syncro Text

Syncro Window

Fa B Import from "
— Midi / Audio - Start the Syncro

DOY TO THE WORLD

Joy to the world! The Lord is come!
Let earth receive her King!

Let every heart prepare Him room,
And heav'n and nature sing,

and heav'n and nature sing, =5
and heav'n and nature sing,
and heav'n and heav'n

and nature sing! seek rewind when
Joy to the world! the Savior reigns; Backspace [Back)
Let men their songs employ;

While field and floods,

rocks, hils, and plains.

Repeat the sounding joy,

Repeat the sounding joy,

Repeat the sounding joy,

Repeat, repeat the sounding joy.

He rules the world with truth and grace
And makes the nations prove

The glories of His righteousness, Play - Pause
And wonders of His love,

And wonders of His love, INFO SYNCRO
And wonders of His love,

Insert the '&' character
at the beginning of
Preview each row to use the
alternative coloring for
that row

B Chord mode Synchronization method: & Perrow @& Byword O By syllable

The text is loaded by writing it, pasting it into the window or by opening a TXT file with the

key-.

Ea
|1 |

With the key , you can save the text on a TXT file, while with the key you can convert all
text to the uppercase equivalent.

With the “Import from Midi/Audio” button it is possible to import a text already synchronized
from a midi file or from an audio file. This procedure is available only for audio and video
files.Synchronization can be done per line, per word and per syllable.

To synchronize, press the "Start Synchro" button. At this point the song will start, and pressing the
enter key, repeatedly and in time with the song, will synchronize.

Star how to enter chords by checking the "Chord mode" box.

For any modification of the synchronized text or of the Chords, refer to the "Edit mode" section of
the Display menu.
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GLOBAL TRANSPOSE
With this option it is possible to apply a global transposition to our entire repertoire.
The semitone increments are added to those existing in the stored songs.
The display is placed at the top right in Performance mode
Winlive Pro 14.0

File Strumenti

Visualizzazione

Master Key 0 =+ Reset/Close

WSE WINLIVE SYNTH ENGINE SETTINGS

In this window we can set different parameters for the WINLIVE SYNTH ENGINE, that is for the
WINLIVE internal sound bank.

We can adjust the WSE COMPRESSOR and FILTER ENHANCER values, set the POLYPHONY, assign a
pitch to cents, establish whether or not we want the effects on the drums and adjust the
equalization of the internal sounds of the Winlive by enabling the parametric equalizer. We can
enable or disable (recommended for slow PCs) the effects relating to the sounds

Winlive Synth Engine DSP settings
b B B Fine Tune (+100/-100)

64 notes e 0 o

Poliphony (for each tracks)

W WSE COMPRESSOR M FILTER ENHANCER

Presets 440hz 432hz

Gain  TsHold  Ratio Gain  Freq  Ampl-Wdh
Drumkit mode Effects Equalizer Preset

15
Reverber type
Modern Rev

Delay type

Winlive Delay

MNotes only

MFX multi effects
Enable DELAY MFX

EXTRA MFX
(Dist,Phaser,Emph,Comp)

AUTO ASSINGH MFX
Disattiva i multi effetti e
canali midi multipli per
avere prestazioni elevate
Disattiva i suoni del

pacchetto ICE per
risparmiare memoria

&
ICE PACK v.1.04

—SELECT PRESET—

W EQUALIZER ENABLE
Lo Mid High

N

Cancel

Finally, if we have purchased the ICE SOUND PACK we can update it or decide to deactivate it
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WINLIVE AUDIO SETTINGS

Unlike the previous window, here we can decide the parameters relating to the audio.

To the master track or second audio track, to the compressor or filter enhancer and finally the
micro-tuning

Audio Volume Winlive Audio DSP settings
Master - 2nd track

— = AUDND COMPRESSOR Il FILTER ENHANCER

i i Gain TzHald Ratio

Gain Freq  Ampl-wdh

Fine Tune (+100/-100])

0 s

Presets 440hz 432hz

Swap Engine Version

|1 1| ¥
Engine version 13.6.0.9 Cancel
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AUTO-EXTRACTION CHORDS FROM MIDIFILE
We remind you that Winlive has a system to calculate chords automatically and in real time for
midifiles. If we want to refine the search we can use this advanced function.

rackMute Instrument
B *Natural Grand Br.

! M Real El.Bass

M Bowed Glass
*Harmonica 1

B Rock Organ

M “F.Clean Gir 1

B Legato Strings Hype
B Slow Strings Hype

-]

Pl =t

(o1

* 500 s B LN s

=
=

*Rock Kit ICE

1.
iy |

B Accordi semplificati

2 Accordi per misura

CALCOLA ACCORDI ORA

you can decide several parameters:
select the midi tracks, simplify the chords and decide how many chords for each measure



BACKGROUND SONGS
This function will allow you to create a list of audio files that can be used as a background playlist
when the Winlive is put into Stop.

Background Songs - Sottefonde

== ?ﬁ' Afa afA Random ‘

Abba Dancing Queen (Official Music Video Remastered
ABBA Gimme! Gimme! Gimme! (A Man After Midnight
Abba Mamma Mia (Official Music Video

A-Ha - Take On Me

Al Bano w0026 Romina Power Felicita ®* TopPo
Alphaville - Big In lapan

Alphaville - Forever Young

Eﬁ;’rriffanFTal:japnp:;:nE Vol Fadeln Fade Qut
Bananarama - Venus(Baby She's Got It) — —
Bandolero - Paris Latino B Taglia silenzio iniziale
Belinda Carlisle - Heaven Is A Place On Earth

Riprendi dallo stesso punto
della song

Tempo di attesa per la musica di
sottofondo

Immediate L

Immagine di sottofondo

Total Songs Current Song Total Elapsed
14 Mo song loaded

This function will allow you to create a list of audio files that can be used as a background playlist
when the Winlive is put into Stop.

Through the Add song button, you can add audio files in the playlist.

With Remove Song you remove the selected song

Uploading playlist allows you to use a previously saved playlist;

Save playlist allows you to save the list loaded at that moment you are working on it;

Delete all the songs shown is used to delete all the songs from your list of the ones you have
selected;

A / a makes the font smaller while a / A makes the font bigger and finally Random allows random
playback of the tracks in the background.

This function also allows you to adjust the execution volume, the fade in for a gradual entry of the
substrate and the fade out for a gradual exit.

With the initial silence cut, it is possible to eliminate the silences at the beginning of the song
finally it is possible to establish a wait (in seconds) before starting.

Finally, during the background, it is possible to insert an image to be displayed for example on an
external monitor or video projector.

In the background function you can also insert videos but only the audio will be played.
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SCROLLING KARAOKE OPTION

On this screen, you can use various parameters to customize the scrolling text and moving
background images. We remind you that at the moment this function is not available for Mac OSx
systems

Scrolling karaoke options

Powered by DIRECTX

TEXT-TEXTURE RESOLUTION
POST PROCESSING FILTER RECOMMENDED :1024x1024

Linear Filter (default) 1024 x 1024 I

ANIMATION MODE (slow)—-ANIMATION SPEED-- (fast)

Moving animation with fade n . '

SHADOW MODE KARAOKE OPACITY

| Normal Border (dafault)

SCROLLING TIME

GUIDE
The manuals and audio and video media for the program are displayed

SUPPORT
The current version of the program is displayed. The personal account, serial number and related
license. It is also possible to log into your account on the Promusicsoftware website.

REPAIR / INSTALL VIDEO CODEC

It can rarely happen that, especially due to Windows updates, video files are not played properly
(no sound or no video). This feature allows us to restore everything. For example, if we launch a
video and we do not hear the audio, we can click on the following function then OPEN FOLDER and
finally launch the K-Lite_Codec_Pack_1205_Basic file. Continue until you install the codec package.
At the end of the installation we will hear the missing audio

UPDATES

This function will allow us to verify that
there are new updates to the program, free
or paid.
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Performance mode

Below is the “Performance’ screen of WINLIVE PRO SYNTH 14

Winlive Pro 140

View mode Database _ Extra/Help _ Demo Songs

File Tools

II Elapsed Total CountDown Signature Curren
144 Emm@ 00:00 00:00 N/A N/A

v

tablet keyboard ﬁ

save button

WINLIVE

song progress
change key and .
change tempo quick icons

song being played song booked

/7

8 | Quickic

o [} uick icons
Hh- o +

The SongList

The SonglList is the “heart of the program” accessible through function Keys or m
The name of the song will be showed in the grid (as set in the database) as well as the typology, so
the file format, indicated by a specific colour.
The songs with lyrics are distinguished by the icon
The cursor buttons (the 4 arrows) of the keyboard can be used to select the files.
There are a total of 39 SongLists (or playlists) that can be called with buttons:

e For PC Windows

e from F1 to F9 (from playlist 1 to 9)

e Shift + [ from F1 to F10 ] (from playlist 11 to 20)

e Ctrl + [ from F1 to F10 ] (from playlist 21 to 30)

e Shift + Ctrl + [ from F1 to F10 ] (from playlist 31 to 40)

e For Mac

e Press the function keys (as PC windows)
e Push the button “?”’ and type the playlist number (from playlist 1 to 40)
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In addition, it is possible to set special SongLists:

- F10 (temporary Songlist) it is possible to add songs from other SongLists by pressing the button
‘INS’ or clicking the right mouse button then ‘add to F10’ or by selecting the song and pressing the
+ button

- F11, F12 (song folder list) it is possible to add all files of a folder to one of the two lists, to set a

folder push from keyboard ‘\’ or @
The combination of buttons Shift + F11 or Shift + F12 of the keyboard allows you to view the
whole database in a single SongList

The button BACKSPACE or opens the research bar (picture below)

[ vou MAKE i

LET METRY AGAIN =

MY WAY =
(<]

Sophisticated Lady

The research can be done on the single SongList or on everyone else (putting the check on “All The
SonglLists”)

It is possible to scroll the results through the button “TAB” of the keyboard, for example a
research of “HELLO” will give you results such as “HELLO DOLLY”’, “I SAY HELLO"”, and so on.

If the author and the artist are set in the database, we can filter the playlist viewing only the
results related to certain authors or artists. To view the playlist another time, you just need to click
on “ALL”. It is now possible to do a research in the whole database simply pushing buttons “Shift +
F11” or “Shift + F12” from keyboard, which allows you to view all the results.

From drop-down menu, we can select the typology of file to search for (midi, audio, video).
Furthermore, it is possible to view and filter the songs according to certain features: for example,
if we type the word “WAY”’ then pressing the button “TITLE”, you could see only the songs that
contain the word “WAY”'.
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POPUP MENU

Winlive Pro 140

View mode Tools Database  Extra/Help  DemoSongs __ Remote Support User: Promusicsoftware PDE - 8X

=) Elapsed Total CountDown Signature  Current
EEE 00:00 _ 00:00 N/A N/A N/A No song Loaded

Load File

SaveFile

\\\\\\\

Window size

Main Karaoke mode
Enlarge Font
Shrink Font

n ST

e b 8 B «- . - DN EE IR F
Clicking on right button of the mouse, on the main screen of Winlive it is possible to open a Popup
Menu, from which you can have access to different functionalities:

e Load File: read files quickly without inserting them in the database;

e Save File: physical saving of files (see dedicated section);

e Create or edit WMT file (Audio-Multitracks): allows editing or creating a multi-track audio
file in the proprietary wmt (winlive multi tracks) format

e Load song Audio multitrack: load an audio multitrack song (see dedicated section);

e Generate Songbook (lyrics and chords): A file with lyrics and chords is generated;

e Events managment: Enable the Events Window feature to associate events with midi and
audio files. This function generates an associated file with the extension * .wen

e View Tracks: opens the screen to view note and audio events in midi and audio tracks

e Set Folder: quick access to SongFolder List (F11 and F12);

e Fullscreen: full screen view of the main screen;

e Normal: restore the view with menu and control bar;

e Minimize: the picture of Performane is closed as icon;

e Window size: allows to reduce the window dimensions;

e Karaoke mode: allows to choose the different modes: Multiline scrolling karaoke, Classic (2
lines), Modern Style (4 lines), Music stand Mode, Music stand with chords, Music stand 6 lines, 2
lines at the top (musician style), 2 lines at the top (karaoke style no chords) or no karaoke;

e Enlarge Font: allows to enlarge the font dimension;

e Reduce Font : allows to reduce the font dimension;

e Font: allows to change font type, style and dimensions;

e Use background image: displays or removes the background image;

e Monitor Background: allows you to load an image as background

e Karaoke Monitor: allows to enable the second screen (see dedicated section);

e Karaoke Monitor mode: allows to choose the view mode of the monitor and the dimension
of font;
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Clone Monitor: enables and disables a clone monitor of main monitor or karaoke monitor;
Do not include in Performed song list: (avoid inserting the song in the list of songs

performed);

Lock keyboard (CTRL+S): choosing this function the buttons are disabled; pushing a function

button the keyboard restarts working;

Stop-Panic: stops the playback of the files and re-initialises any expander;
Import into database: import a song directly into the database.
YouTube start: set a starting point of the song connected to YouTube
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CONTROL BAR

[N54
s

i’—) Quick lcons
Hh- o +

The CONTROL BAR is divided into 4 parts, the left part (transport bar) is reserved to control
buttons of the song, the second part is related to the song which is playing at the moment (Main
Song), the third part to the song which has been booked (next song).

The fourth part is composed of a series of buttons, quick to access to different functions and mode
QUICK ICONS (these quick buttons may not be viewed if the monitor resolution doesn’t allow it:
for example netbook or notebook with low resolution screen)

Through the buttons placed in the bar below it is possible to control:

Melody channel (on or off) for the midis;

The tempo in BPM compared to the original tempo for midifiles;

The key change for midi, audio and video files.

Once the time and the custom tone are set (also for volume and other parameters which can be
checked from Mixer- see dedicated section), it is possible to save these parameters virtually in the

database, pushing the button ]El placed up. So, every time you will launch the edit file, this will
be performed with all the made changes and the modified parameters will be conserved also after
quitting the program.

By clicking on the song title or on the Artist, you can access the Quick Edit function.

Title MY WAY Gen.Note
Artist Author

PDFIMG:
TEXTFILE:

File: cA\Users\PME\Desktop\BASI OK\basi\SONGSERVICE ITA ESTRA\Frank Sinatra - My Way. MID

Kar: [K]
File duration: 4:41:622 Song list Duplicate
ID: 1013 F2 - 2 : SonglList 2

This function allows so the quick editing in Title, Artist, Author, Key field and it is also possible to
change the SonglList.
It is also possible to associate an image / pdf or text (txt,rtf)

We can replace the source file by pressing on the left on the image with 3 dots -
Through the buttonm it is possible to locate quickly the file on Hard disk

With the buttonﬁ it is possible to cancel the file in the database (the physical file stays instead
in Hard disk). Clicking twice on the icon [ it is possible to choose arbitrarily whether the song has
lyrics or not.
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MARKERS

D L.iIntr Ners 4.Chor 5.Vers

MID  &.Chor 7.Coda 8.Fine I

The markers allow quick access to various sections within a song. To register them, it is necessary
to enter the Edit mode (see dedicated chapter).

When one of the markers is set as the starting Marker, the background of the button
corresponding to the Marker turns green; on the other hand, when one of the markers is set as
the final Marker, the background turns red.

Setting the starting markers can be useful, for example, in order to skip the introductory part and
start the song directly from the verse.

It is possible to quickly access the markers by clicking with the mouse on the button corresponding
to the Marker, or by using the numeric keys (from 1 to 0). For midi files, pressing the Marker via
the numeric keypad will allow you to access the reserved point "in time".

The creation of the markers can be performed in the Edit mode or they can be created "on the fly"
in the performance mode by pressing the ALT + 1, ALT + 2 ... keys. ALT + 10 corresponding to the
10 markers for each file (midi, audio or video)

The midifile purchased from Songservice by M-Live contain the markers already inserted
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PRE-LISTENING
To use this function correctly you need a second audio interface (see chapter Options). It is

accessed by clicking on the button after booking an audio song (MP3 or WAV).
0:03:807

> 44 W CueDk Test Set

[ nocue ICINGING

House Of The Rising Sun

For a quick setting, pause at the right time (typically SPACEBAR) and then press ENTER or click on

the button . When called, the song will start from the chosen cue point.

For more detailed use:

With the Set key (J) it is possible to set the starting point of the song, and with the Test key (H) it is
possible to preview the song from the set point. With the << or >> transport keys it is possible to
edit the starting point precisely. It is also possible, via the Gain bar, to set the volume of the song.
Once the pre-listening is finished, you can confirm the cue point with CueOK (or G key) and exit by

saving the changes with the key , or exit and cancel by clicking on
When the song being played ends, or mixing (Y key), fading out (Q key) or immediate start (send),
the booked song will start from the point set during pre-listening.
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VIRTUAL KEYBOARD

Enabled by pressing the button at the top right of the video in Performance mode, Virtual
Keyboard allows you to activate this screen as shown in the photo below:

Stop ’ i 1 Scroll  Scroll Key - Key +
Shift Ctrl <-Back el  <<Rw Fw>> M -F10 +F10 |_> ’I‘

Song list
DANCE LATIN  Songlist5 Songlist6 Songlist7 Songlist8 Songlist 9 TEMP Start Mix

It allows you to use the basic commands if we use WINLIVE on TABLET WINDOWS or touch screen.
The F1 / F9, Shift F1 / F10, Ctrl F1 / F10, Shift + Ctrl F1 / F10 keys are used to select the SongLists;
The names of the various songlists are given.

Esc closes the list.

the left and right arrows scroll the list in the commanded direction.

the + F10 and - F10 keys remove or add songs in the provisional list F10.

Start, allows you to start playing the selected song.

Mix, allows mixing between one song and the next.

the X button closes this screen.
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AUDIO TRACK RECORDING
This function allows you to record an audio track on a song (midi, audio or video) included in the
database

Start a song and press the record key: .

Filename : C) \PMS\Docume inlivePRO\MEDIA AND TE
Device: - choDev ~ \House Of The Rising Sun.wa

Start record
Line: -
WAV Format:
Volume: Bl 100% PCM - 44.1 kHz 16 Bit Ster:
Start Test

From the panel you can select the Audio device, Line and input Volume that has a signal
adjustment fader. The Filename indicates the saving path of the recorded track, but it is possible
to change it by typing the appropriate key.

WAV Format indicates the standard format for saving the track, but this can also be changed.

By clicking on Start Test you can perform a recording test by checking the incoming volume level.
At the end of the test, the button Stop test allows you to return to the initial condition.

The Start record and Stop buttons are used respectively to start and end recording tracks.

The recorded track will be associated with the song in database in the MEDIA column and in
performance a Second Track window will appear next to the song title.

Clicking on Second Track will open the following screen:

I Second Track Mixer
- FX1  vocal Delay

FX2 Vocal

Offset:(ms) 0

G [Lintr] 2.chor 3.inte 4.Chor S.inte

MID 6.Brid 7.Chor 8.Inte 9.Solo 0.Chor

From left to right you will find: the volume of the second track, the FX1 and FX2 effects that you
can combine with the second track and their levels.

Below with Offset (ms) we can anticipate or postpone in milliseconds the second track with
respect to the song.

Everything can be saved virtually with the quick save button

If you want to export the song and its second track into a single audio or video file, you must press
the SAVE FILE function in the File menu.

Note: at the moment this function is not enabled on Mac OSx
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Edit mode

In this mode we can edit different parameters of our song.
- Create markers

- Change the structure of our song

- Graphically edit our text included within our song

- Edit chords graphically

- Insert images for each marker

- Save the text of an audio in LyricsID3 format, etc

Winlive Pro 14.0
User: Promusicsoftware G E - GX
MY WAY -

File View mode Tools Database _Extra/Help ___Demo Songs __Remote Support

rrrrrr

MORE, MUCH MORE THAN THIS

A7 Emin7 D
I DID IT MY WAY

Song markers
Midi Auto  Start from a marker

A 410 30 1:1+10ms 30 +10 + Chords

8

o ~ Quick icons
s

J= = 5 * BBEBBBMM

H- o +

Sophisticated Lady

Markers

The use of the Markers allows the jump in real time to different points of the song. For example,
you can associate the first marker with the introduction, the second one with the first verse, the
third in correspondence of the refrain, etc.

The maximum number of markers is 10 per song.

There are several ways to register new Markers while reproducing a song:

e Pressing ALT + [number from 1 to 0];

e Clicking on the Marker you want to generate, then click on the button .
e By aright-clicking on the bar at the bottom

e Clicking the 'L' key (adds them in order).

To relocate the Markers:
e Use the ALT and + or ALT and - keys
e Left click on the bar at the bottom, and move it with the mouse.
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e Use the keys for an increasingly precise Marker position
Song markers

1 -10 30 ©:1+4ms  +30 +10 +1 >

To remove a Marker, select it on the table or on the bar at the bottom, and then press DELETE.
You can rename the markers by double clicking on the table.

|
Using the key it is possible to add images associated with the various Markers (for example,
you can add the image of a score) so that you can show one or more images per song in progress.

You can use Markers to set a song starting and ending point.

For example, Marker 2 can be set to the first verse, skipping the Introduction, and Marker 9 at the
end of the penultimate verse, to end the song before the "tail".

Once the Markers have been set, and any starting and ending points, it is necessary to save by
clicking on the Save button.

The Markers can be saved only if the file (Audio or Midi) has been previously imported into the
database.

While the song is playing, the Markers can be quickly called up by pressing the number on the
corresponding keyboard while for the midifiles the next beat of the song will be expected.

With the combination Shift + [numeric key], the changeover to the called Marker will take place
immediately.

If the Markers are saved they will be visible in the next song bar, pressing Control + [numeric key],
or clicking on the booked song Marker, in Performance, will allow the next song to start from an
arbitrarily chosen Marker.
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Visual Mixer

Next to the markers function, a simplified version of the Mixer is visible, valid for midifiles and
audio multitracks.

'Song markers New Syncro

- Midi Auto 5
4 -10 -30 0:1+105ms +30 +10 +1 » L e Start from a marker

Gpee— e

1 b 3 4 5 [ 7 8 9 10 {0)

wio
IIIHHIIIIIIIHHIIIIIIIHHIIIIIIIIHIHIIIIIIII\HIIIIIIIHHIIIIIIIIIHHIIIIIIHH IIIIH\\IIIIIIIIHIHIIIIIIII\HIIIIIIIHHIIIII [ IIHHIIIIIIIHH L L IHHIIIIIIIIHIHIIIIIIII\HIIIIIIIHHIIIIIIIIIHHIIIIIIIHHI

10 20 30 40 50 00 110 20 1:30 140 180 zo00 & 240 400 400 420 430 440 480
Press ALT + 1 .. 0 to register the markers, ALT and +/- to set

]

Flute Natural @_Timpani Real

#, | ¥ Quick lcons

)
- Lo * BB m

J.
- o +

3 Demosongs 44 o

SR

For each individual channel it is possible to adjust the volume, mute or change instruments (by
clicking on the instrument name of the corresponding channel).
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LYRICS EDITOR
It can be activated with the key which is located in the lower right-hand corner.
Here you can change the text or its position within the song.

GMaj?

o7
=
[}

7
: e
s | CHORD|
) Guick lcons
-l BBBB&E&&
Hh- o +

By clicking on each word, it is possible to edit it by changing the text, or move it graphically by
anticipating or postponing it.

The Shift - Slide allows you to translate the entire text, anticipating or postponing it by a certain
number of Milliseconds, indicated hereafter.

14
By clicking on this icon we can change the color of a line for example to highlight a phrase
that will be sung by another singer

The button capitalizes the whole text and the next key all in MINUSCOLOCK

This automatically optimizes the text by moving the page changes in order to simplify the
reading of the Karaoke during the playback; it removes the double empty lines or pages too. ton

Allows the insertion of new text.
u Deletes all lyrics

With this key, on the other hand, you can save in ID3V1 format compatible with many
systems (such as Ketron Midijay) that use the display of the text line by line.

With the SAVE key you save all the changes made.
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CHORDS EDITOR

Like the Karaoke Editor, you can access the Chord Editor to edit the chords, using the button k

Karaoke/Chords Edit

Test- Pl p il SHIFT - SLIDE

L O o
OO kZ) 0 140

' CHE FA  UHE'A SA

0 VE MO TE . [ g
' ME TE N ME TEJAM  CO
CA RE CuF CA RE PEC LU M 0§

= MYSONGS-1 Songlists 'A FRANGESA STOP o 8 |~ Quickicons

)
Mt = - +
PR M Quick g 2l o1 MTD MDL EDT CHD | VL= | VL-
% Chor 5.Vers c
[Tl e e h=lo +

Here you can edit the chords and change their position in reference to the text below.

After editing press the SAVE button to save the chords within the file.

Remember that, unlike text, there is no standard format for chords so currently the chords
entered or edited by WINLIVE are read only by WINLIVE series programs for PC (Windows or
MacOSx) or WINLIVE APP (Android or iOS)
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Database mode

Below is the DATABASE grid of Winlive Pro Synth 14

4% Database - [u] X

Database - Menu Help

0

From Performance it is possible to access the database by clicking on the menu at the top
Database -> Database or from View mode -> Database or by clicking the quick button (quick
icons) DBS

It can be accessed without using the mouse by pressing the [CTRL+ALT+D] keys

Winlive Pro Synth 14 allows you to manage multiple databases.

—
[

e Tocreate a new database press the button:
Winlive will ask whether to save the already present database, after which it will empty the
current database.

e To open an existing database press the button: a

Winlive will ask you to specify the name of the database to open.

a e

L ]

) P

e To save the current database with a name press: k=
Winlive will ask you to specify the name of the database to save.

L 775

e To make a backup of the database press: &)

®
e Torestore the previously created backup press the button: =
Winlive will show the backup date and time.

Warning: creating a new database, or restoring a backup, will delete the one previously created if
you do not save it.
- Edit the cells
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You can change the cells values by double clicking on each cell if you are in "Selection" mode or by
pressing the "E" key. You just need a single click when in "Edit" mode.

On some fields the entry process will be guided, on others it is possible to write directly inside,
other fields are informative and it will not be possible to edit them, for example Type field, ID...

It is possible to edit some values quickly through the "Preview" window that allows you to listen
quickly to a preview with new settings applied.

Right clicking on a cell (or on a selection of cells) allows you to access a menu through

which you can perform various operations:

- Select all: highlight all songs [CTRL+A]

- Reset selection: cancels the selection of the tracks [CTRL+N]

- Copy: copy [CTRL+C]

- Edit: edit the selected cell

- Multi field insertion: if multiple songs are selected it allows multiple entry in different

fields.

- Sort A-Z: sort in ascending order in the selected column

- Sort Z-A: sort in descending order in the selected column

- Delete database: delete the song from the database but not physically from the hard disk

- Sort grouped by SonglList: sorting in ascending order according to the SonglList

- Get interpreter / author from folder name: the folder name is displayed in the Artist

column.

- Move to List: move the selected songs from one SongList to another

- Copy to List: copy the selected songs to a SonglList

- Restore files-Path (scanning): this important function allows you to restore the path if the

files have been physically moved from one folder to another. It is also possible to restore

the path for the files of the MEDIA and TEXTFILES columns

- Replace part of the path: replaces a complete route or part of it with a different one. For

example if | physically moved some songs from the folder C: \ SONGS in D: \ MY SONGS |
have to select the interested songs and write as in the picture

Replace part of the path / File name

Change From :
C:\MY SONG

To..New Path
D:\MY NEW SONG]|

- Mute channels: to select the channels to be muted

- Copy IN: physically copies the songs from one folder to another with the possibility of
updating the paths in the database

- Move IN: physically move the songs from one folder to another with the possibility of
updating the paths in the database
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- Find and show duplicate files: this function is accessible from the key..
It shows duplicates in different ways. Most of times, the duplicated files can be conceived
as a song coming from the same list or with the same title of the first one.
Once the database field to be set as a parameter for the duplicate file has been arranged,
the priority must be chosen (ID as loading order or belonging SongList).

Search and show duplicated files

Database field Priority

O File ® Title OID @ Songlist @ IDdesc @ Songlist desc

Duplicate files: 0 ‘

Once the CHECK button is pressed, the duplicated tracks come up.

Search and show duplicated files
Database field Priority

Lo I =1F ® Title OID ® Songlist @ IDdesc @ Songlist desc

Duplicate files: 28 ‘

Check

Operazioni

Works on full path (default) Works on title and filename Works on equal titles

This operation is irreversible, therefore we recommend that you save the database first.

- File analysis - Mp3 tag info: this function extrapolates the information inside the mp3 files such
as title, artist etc.

- Convert title/Author/Artist to: set of text functions such as upper case, lower case, eliminate
unnecessary spaces, etc. for example Use file name as title: the file name is displayed in the TITLE
column

- Divide title field: allows to divide title and Artist if these details are both present in the TITLE
column

- Duplicate: it is used to duplicate the selected files

- Locate files on disk: directly opens the source folder of the files on the hard disk

- Remove file from disk: allows you to physically delete the file from the disk and simultaneously
from the database. This function is irreversible.

- Create and save YTB file (YouTube song): once a YouTube song is selected, it is saved into an
external physical file. Do not forget that the YouTube file is a simple link to a YouTube video.
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-Multi-selection

If you hold down the CTRL key, you can select multiple songs in order to operate in groups.

If you are in Selection mode, the song is deselected by clicking on it, while in Edit mode just click
on any field to deselect everything.

Database columns

Below is the sequence the columns of the database

ID: indicates the number in chronological progression of the imported songs

SonglList: the belonging SongList is displayed

Title: indicates the title of the song

Artist: performer of the piece (artist)

Author: author of the piece.

Genre_Notes: we can enter the genre of the song or annotations on the song itself

Type: value not editable. Indicates the type of file (mid, mp3, video, etc.)

Karaoke: value not editable. Indicates the presence of the text within the file. It is valid only for
midi files and mp3s

Tempo: value not editable. It is the time relative to the song

TempoP: it is the edited time

ChOff: indicates muted channels for midifiles

Transpose: displays the changed pitch

Volume: the standard volume of the song (100 means volume as in the original)

Media: file associated with the song (for example associating a pdf, an image, a sound, etc.)
Textfile: Text associated with the song (txt or rtf)

Order: allows you to create a custom order of the songs in the set list

When we want to create a custom order, we have to insert a series of numbers in order to create
a numerical criterion

For example if we want to create a playlist with this personalized sequence

IMAGINE - YESTERDAY - MICHELLE - LET IT BE

We will insert these numbers for example: IMAGINE (15) - YESTERDAY (21) - MICHELLE (50) - LETIT
BE (88). No matter what numbers we enter, the important thing is to create an increasing number
sequence

After doing this, remember to assign this sorting order to this SonglList in SONGLIST EDITOR
'E' https://youtu.be/y5E5pEAKWag

Key: indicates the key of the song
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Import of the songs

Start entering some songs by clicking on the left side of the database.

Select a folder and open it with a double click. The songs contained in the folder in question will
appear. If the folder is located on the desktop or in Docs folder, we can view them simply by

Desktop Docs

clicking the buttons

We can select a song, several songs (by holding down the CTRL key) or all the songs in the folder

by pressing the button

2]

By clicking on EERLULS | the selected files are imported.

Database Tool Window
Song Import
Song Select

Song list: M +Shift W +Cirl
F1- 1 SongList 1

Rename songlist

| |

Mute channels:

H1l1NE? H3 B3 ES5

HS H10MNI11 N 12 W 13 14

B Use file name as title

Quick import (lgnore genre, artst ...}

H Do not import if it already exists in the database

W Write Artist as folder name

Total song to be imported

Now you can select:

+* The destination SonglList;

Rename songlist: it is possible in this procedure to name our songlist;

Copy TO: a secondary folder where to save the copies of the imported files;

MOVE: the selected files are physically moved to another folder

The mute channels for Midi files;

Use file name as title: displays the name of the file as the title of the song (Title column)

instead of the title that is usually included in the file itself;

Quick import: speeds up the import by ignoring some information;

Do not import if it already exists in the database: avoid uploading files down in the

database;

% Write Interpreter as folder name: write the artist of the piece (Artist column) by taking
information from the last folder that contained the above mentioned song.

X/ X/ X/ X/
AXIR X R X SR X

K/
X4

D)

K/
°e

K/
X4

)

e
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Note: fast import performs the process extremely quickly but does not allow thorough checks on
the integrity of the file and the MP3 tags.

In any case, files that are deemed invalid, such as Midi that have notes jammed or lacking vital
information will not be imported in order not to compromise any user performance.

In any case, at the end of the import a short report will appear about the imported and invalid
files.

Attention: the integrity checks will not be provided on the files of the Song Folder Lists and on the
files launched with Load File

Database Icons
Database status bar

o .
BAA -
Respectively: deselect all, select all, select multiple and Database setup for

changing display parameters.

Display criteria
All song lists

Supported files

Set filters on the display based on the type of File and / or the SonglList to
which it belongs

In the order:

+* Return to Performance mode

+* Open a database (new)

++» Save a database

+» New database

+» Import database from a previous version
% Find and show duplicate files

+* Make a backup of the database

++» Restoration of the previous backup

Y

*
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Let us now dwell on the last 3 icons that are part of the new function

DATABASE SYNCRO

OO

This important function allows you to save your database with all its associated songs and files to
the cloud.
This will allow us to:

®,

*» Save our entire database in the cloud and resume it in case of accidental deletion:

¢+ Transfer to a secondary PC the database with related songs so that we will always have a
synchronized and updated database.

A space of 10 Giga is provided, free of charge, for this function provided that you use the latest

version of WINLIVE

This is done as follows:
from the Main PC:
after you have finished your work on the database you click on the following icon in
E order to transfer, automatically, all the database and related songs to a reserved space in
our servers. The first time you perform this operation the system will pass all the files in
the database and therefore the time taken will be relative to the transfer of all the files. In a
second step only the modified files and the new files entered in the database will be transferred.
Transfer times depend on the number of files, their size, and the Internet connection.

from the secondary PC:

By clicking on the following icon on the secondary PC, the system will download both the
database and all related files sent to the cloud from the Main PC and physically they will
be saved, unless otherwise located, in the IMPORTED SONGS folder found in the
WINLIVE PRO folder which in turn is located in Documents. Again, the first time all files will be
downloaded while in a second operation only modified or new files will be downloaded. Of course,
even in downloading, transfer times depend on the number of files, their size, and your Internet
connection.

Info spazio in cloud
By clicking on this icon we will know the size of our cloud space, the space occupied, the
destination path of the downloaded files on the secondary computer, and the free space
on our PC Hard Disk. Also with the Delete ALL function we could delete all the content in
cloud. The SYNCRO ID identifies our file transfer.
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DATABASE FUNCTIONS
Database functions

BIcARRO®

CchMY+B oD

Top row:
¢+ Move the songs to another SongList
Open Import Song window
Delete song or song selection from database
Delete all the songs now shown in the grid even if not selected
Use file name as title for the selected song
Search for a title among the songs on the grid
Open Karaoke monitor
Import the Playlists of Vanbasco

X/
X4

L)

X/
X4

X/
X

>

X/
*

L)

X/ X/ X/
R X R X4

Bottom row:

*» Copy the file to another physical destination

Search for “orphan” files (files missing or with wrong path)
Open the SongList Manager (SongList editor)

“* Replaces the path or file name

% Search and show duplicates

%+ Create a database report (excel or html report)

++» Locate the file on the hard disk

7

% -Title optimization



ORPHAN FILES (missing files)

To search for orphan files, click on the button m
Tip: positioning an icon on a small label will give a brief description

Orphan Files

dlabase oo

Missing files

Check it out Enlarge >>> ‘

Missing files 23723
C:\00 MATERIALE LAVORO\BASI DA SELEZIONARENOOO\UNA RAGAZZA IN DUE DEV.
C:\00 MATERIALE LAVOROA\BASI DA SELEZIOMARENOOO\TANTO PE CANTA' samba.m
C:\00 MATERIALE LAVORO\BASI DA SELEZIOMARE\000\Stop Bajon (Michael Gray In
C:\00 MATERIALE LAVORO\BASI DA SELEZIOMNARENOO0N\Se tu non torni - Miguel Bosi
C:\00 MATERIALE LAWORO\BASI DA SELEZIONARE\OOO\SE MI LASCI DEV.MP3

C:\00 MATERIALE LAWVOROA\BASI DA SELEZIOMARENOOO\putesse essere allero.mpd
C:\00 MATERIALE LAVORO\BASI DA SELEZIOMNARENOOO\PIAZZA GRANDE STRUM.mE
C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\OOO\PAPA CHICO.mp3

C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\OOO\O SURDATO MMNAMMURATC
C:\00 MATERIALE LAVOROA\BASI DA SELEZIOMNARENOOO\MEW YORK CITY GIRL DEV.W
C:\00 MATERIALE LAVORO\BASI DA SELEZIOMNARENOOO\MAPULE & dev.MP3

C:\00 MATERIALE LAWORO\BASI DA SELEZIOMARENOOO\ME NE ANDRO' DEV.MP3
C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\OOO\MA IL CIELO E' SEMPRE DEV
C:\00 MATERIALE LAVOROA\BASI DA SELEZIONARENDOO ' uomo.mp3

C:\00 MATERIALE LAWVORO\BASI DA SELEZIOMNARENOOO\L'AMMO CHE VERRA' DEV.M
C:\00 MATERIALE LAVOROA\BASI DA SELEZIOMNARE\OOO\Gabriella Ferri La Societa' [

E 4

Remove all Show in database New Path

The Orphan File Search feature allows you to scan the entire database looking for files that are
missing in a way that may have been deleted or moved to another folder.

To find orphan files, press the "Check" button. Once the scan is complete, you can delete matches
from the database (Remove All), or show them in the database. The Search function searches for

all orphan files and once identified, the relative path in the database is automatically updated.

With New path, on the other hand, the new path is updated manually.
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Media explorer

We suggest our users who have tens of thousands of songs use the two modes: Database and
Media Explorer

In the Database it would be better to insert the songs of your own repertoire that need the
management and the personalized saving of different parameters while in Media Explorer the
simple execution of songs perhaps with variation of transposition and annotations for each song.
The latter mode is especially suitable for those who perform karaoke performances

In Media Explorer, therefore, you can run the Songs directly from the hard disk, with a very fast
and intelligent research, you can also apply display filters and possibly import them into Winlive
database

Winlive Pro 14.0

View mode Tools Database Extra/Help Demo Songs Remote Support User: Promusicsoftware L1} = 5 X

Elapsed Total CountDown Signature  Current i
00:03  4:50:652  -04:49 N/A N/A Background

ITY GIRL DEV -

NEW YORK CITY GIRL

——r

Presets »»> Scan Subfolders file  dir Total : 22 Tt 4 apmam
File name Key +- |Note Complete path
4443 5TRUM mp3 0 C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\OD\4 4 43 STRUM.mp3
as tu as kar dewMP3 C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\OD\as tu as kar devMP3
BALLIAMO KAR DEV OK.MP3 C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\DD\BALLIAMO KAR DEV OK.MP3
bocca di rosamp3 C:\DO MATERIALE LAVORO\BASI DA SELEZIONARE\DD\bocca di rosa.mp3
BONGO BONGO mp3 C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\00\BONGO BONGO.mp3
DON RAFFAE HI PLAY X)0X.mp3 C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\OD\DON RAFFAE HI PLAY XXXX.mp3
donraffae.mp3 C:\0O MATERIALE LAVORO\BASI DA SELEZIONARE\DD\denraffae.mp3
Gabriella Ferri La Societa' Dei Magnaccioni karao C:\DO MATERIALE LAVORO\BASI DA SELEZIONARE\DD\Gabriella Ferri Ls Societa' Dei M
L'ANNO CHE VERRA' DEV.MP3 C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\OD\L'ANNO CHE VERRA' DEV.MP3
I'vomo.mp3 C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\OD\I'ucmao.mp3
MA ILCIELO E' SEMPRE DEV.MP3 C:\0O MATERIALE LAVORO\BASI DA SELEZIONARE\DD\MA IL CIELO E' SEMPRE DEV.MP3
ME NE ANDRO' DEV.MP3 C:\DO MATERIALE LAVORO\BASI DA SELEZIONARE\DD\ME NE ANDRO' DEV.MP3
NAPULE & devMP3 C\00 MATERIALE LAVORO\BASI DA SELEZIONARE\DD\NAPULE & devMP3
NEW YORK CITY GIRL DEV.MP3 C:\00 MATERIALE LAVORO\BASI DA SELEZIONARE\OD\NEW YORK CITY GIRL DEV.MP3
O SURDATO NNAMMURATO DEV 2.MP3 C:\0O MATERIALE LAVORO\BASI DA SELEZIONARE\0D\O SURDATO NNAMMURATQ DEV 2.1
bape o o0 ieo oo ieas QuapE ipao oo

ADD to MODE = Auto Pl
‘ F10 PLAYLISTS F10 e v NEXT . Nlealvl ’I

= Demeo Songs - 44 Sanglists NEW YORK CITY GIRL DEV STOP

o
P HOE e e : : . + i
B -

W=
N

=
(B3,

»

CAEIE ISP 3P R A A S
bocooococooooooooao

w Quick lcons

100
0

)
By clicking on Default >>> you can open predefined paths or you can select a starting folder that
Winlive will search.

Just below we will find boxes to check to decide which files to search for.

The FILE and DIR boxes have the following meanings:

FILE: the keywords of the search will only concern the name of the file.

(e.g. if we enter the word "Sinatra" the search will cover all files that have the word "Sinatra" in the
title. Example filename="Frank Sinatra — My Way.mid")

DIR: the search keywords will only affect the folder name.

(e.g. if we enter the word "Sinatra" the search will cover all the files included in the folders with the
name "Sinatra”. Example "C:\Songs\Sinatra\My way.mid")

If you select both (FILE and DIR) the search will affect both the file name and the folder names.
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RESEARCH

Once you have entered the title of the song or part of it to be searched, WINLIVE quickly searches
for all the songs that meet the search criteria. [BACKSPACE]

Once the search has been done, you can select the song and play it on the fly simply by pressing

[ENTER], or you can book it by pressing the [SPACE BAR] or by clicking on the button .

Play )|

With the button Next

you can play the booked song (or by pressing the [CTRL+ENTER] keys).
NB: To switch to the booked song by mixing press the [CTRL+Y] keys, while to fade away the
[CTRL+Q] keys.

Once the search is performed the files will be displayed in the following columns: (in order from
left to right):

R

s AZ File type: M for midi files, A for audio files, and V for video files. For Midi and Audio

files if we hover over the file title Winlive checks for text by putting the letter K next to the

file type. You can also sort by file type by clicking on the AZ column header.

File Name: represents the name of the file as stored on our PC.

Key +/-: we can determine the key variation of the song before playing it.

* File Notes: we can write a comment at the selected song for example to remind us of a
dedication by the person who requests it.

+* Path Name: indicates the location of the song within our PC by specifying the relative path

7
o0

R/
SO X4

%
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Pressing the right mouse button will open a menu with the following functions:

WINLIVE

Predefiniti >>> a/A Ala L CERCA in sottocartelle fle dir (SN Total: 142 t & Ao

Xt B R Key +-  Note Percorso Completo

Media Explorer
2 way uliana Aquino - | W ive {Lounge Version). 0

A Kind Of Magic mp3 0

2 s
.
o POF
Preferiti - =

Play :Amii Stewart - Knock On Wood (Live 2014).MID

Prenota Song :Amui Stewart - Knock On Wood (Live 2014).MID

Aggiungi ad F10

Metti tutte le song in F10 (max 2000)
Svuota F10

Localizza il file sul disco =
Al Jarresu - After AlLMID

Al Jarreau - Mas Que Nada.MID
ARO SOLER - LA CINTURA mpé
n Wood (Live 2014) MID

Al Jarresu - Afer Al MIT

Al Jarreau - Mas Que Na

Play next:Amii Stewart - Knock On Wood (Live 2014)
Ordina A->Z
Ordina Z->A
Info :Amii Stewart - Knock On Wood (Live 2014).MID
Rename :Amii Stewart - Knock On Wood (Live 2014).MID
Songfists Loredana Berté - IMPORT :Amii Stewart - Knock On Wood (Live 2014) MID

PE<EZ==>>=

S |

MixStd

>

7/
*

Play: plays the current song

Book a song: books the current song. This will be placed in the lower right.

» Add to F10: the current song is placed in a temporary playlist that can be recalled with the
[F10] function key.

+* Putall songs in F10 (max 2000): all songs resulting from the search are placed in the
temporary playlsit F10 for a maximum number of 2,000 songs.

» Empty F10: empties the F10 songlist.

¢ Locate the file on the disk: opens the folder where the song file is physically contained and
highlights it

+* Play next: plays the booked song

*» Sort A->Z: sorts song titles alphabetically from Ato Z

¢ Sort Z->A: sorts song titles alphabetically from Z to A

Info: show file information

Rename: physically rename the song file

IMPORT: imports the selected song into the Database

7
LX)

DS

R/

%

R/
L4

R/
X4

D)

If you want to book more songs you have to go to the song (possibly change the key and
ADD to
annotations) click on s or the [INS] key and so on.

The booked songs will be displayed by pressing the [F10] key or clicking on the button
MODE
PLAYLISTS F10

The reserved tracks will be displayed and infinite PLAYLISTS (*.F10) can be created, saved and
recalled later.
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Options

» GENERAL

Winlive Options
Karaoke Chords
General Pictures Midi 1 Midi 2 SongList Texts CDG / Video Application Name: Winlive Pro Synth
Version 14.0.1

-— Author and Programmer -
Pinto Giuseppe Massimo

-— Creator —
Leonardo Di Pinto

P C L do Cosmai

'Graphic: Monti F Pinto Gi i Di Pinto Gigi
Technical adviser: Di Pinto Leonardo

Supervisor: Di Pinto Lucrezia (Lulu)

-—Contributors-—

Acquafredda Francesco

Mary Chiaro
Alex Ciccio Viola
Di San Leonardo Gaetano
Luca La Paglia
Max Verri
Frisone Nunzio
Di Pinto Mariachiara

Apply Use settings for
minimum
requirements

Cancel
Reset (ALL)
Reset (Audio/Midi)

-Import Visit our website for support:

~Export

WINLIVE

www.promusicsoftware.com

v Stop at the end of each song

Disables automatic reservation of the next song in the list

v’ Stop of the song even if reserved

Disables automatic song playback even if reserved

v" Random next song

Randomly book the next song

v Disable automatic song start

Each song requested does not start automatically but is started with the enter key

v Sliding Melody Bar

The melody bar, which can be called up from the key [E] in performance, can be fixed in
screens or sliding

v View markers and events in the Melody bar

View both markers and events entered via event management

v' Use measure indicators in Melody bar

During the scrolling of the Melody bar it is possible to view a progressive measurement
numbering.

= Melody bar bottom or top

Position the Melody bar when performing in performance

= Vertical Melody indicators, fixed horizontal, horizontal with height

As description
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= Melody Bar only on main screen, only on Karaoke monitor, on both

As description

= Automatic mixing

Mixing mode between a song and the next one or the one reserved: disabled, only audio,
audio and midi

= Milliseconds of waiting before the start

Set the number of milliseconds that the program will wait before playing the song

= Talkover volume

By pressing the [P] key during performance, the volume level drops to the chosen percentage,
allowing you to speak while the song is playing in the background

= Tablet keyboard

Allows to position the virtual keyboard (suitable for Tablet devices) on the right, left or disable
it

v Show scrolling bar in tablet mode

If the virtual keyboard for Tablet is displayed we can show a scroll bar to move more easily
within the songlist. Obviously this feature is important if you are using a tablet without a
physical PC keyboard

= Keysl?2..0

You can use number keys to quickly access to the markers or mute for midifiles tracks from 1
to 10 and with Q,W,E,R,T,Y keys tracks from 11 to 16

= Use the Space for bar

You can use the space bar to play or pause a song, or to show or hide the SongList

= Search Window position

Allows you to move the "search song" window down or up on the screen
v Use ESC twice to stop instead of ESC

If checked, the stop will be effective by pressing ESC twice instead of once
v View clock

View a clock in the upper right

v’ Use high contrast indications

As a description. Requires restarting the program

v" Do not use leds

The LEDs are positioned and are active in correspondence with the various instruments
displayed in the Mixer interface; by ticking this box they are deactivated.

v" Do not use the VU-Meter for midi

The Vu-Meter is active in the Mixer interface to signal the sound level and can be deactivated
by ticking the appropriate box.

v" CountDown flashing end song

The countdown is present at the top center of the performance screen and flashes a few
seconds before the end of the song being played; by removing the check in the appropriate
box, you can cancel it.

v" Automatically hide Tablet keyboard

By ticking the appropriate box, the tablet keyboard can be hidden

v" Auto-Open Visual Mixer when audio multitrack starts

This function is related to the audio multitrack song. You can decide whether to open
automatically when loading an audio multitrack song.
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= Song booked in Karaoke monitor

Option to display or not the booked song in the karaoke monitor, also sizing the display
character

= Key Information and Karaoke Title

Option to view the song being played and its pitch in the karaoke monitor, also sizing the
display character

v" Show Countdown and Watch in karaoke monitor

As description

ADVANCED SETTINGS (expert users)
(It is recommended not to change the default settings unless you are an expert user)

v Check for updates at startup

If checked, it allows you to automatically check for updates at each start.
= Language

Choice of preferred language. Requires restarting the program

= Database Buffer

Set the memory buffer (in KB) to be allocated to the database. Requires restarting the program

= (Video) Interface update

Winlive will update the graphic interface every few milliseconds. Set the value according to the

graphics processor speed.

v Enable frame jump

Mixing two songs delays the display of the image of the following video
It is ticked to save resources on less performing computers
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> MIDI1

Winlive Options

Karaoke Chords
General Pictures Midi 1 Midi 2 Audio Songlist Texts CDG / Video Application Name: Winlive Pro Synth
Version 14.0.1

I | --- Author and Programmer ——
| Pinto Giuseppe Massimo

- Creator —
Leonardo Di Pinto

Prog) C L do Cosmai

‘Graphic: Monti F Pinto Gi i Di Pinto Gigi
Technical adviser: Di Pinto Leonardo

Supervisor: Di Pinto Lucrezia (Lulu)

—Contributors—

Acquafredda Francesco

Mary Chiaro

Alex Ciccio Viola

Di San Leonardo Gaetano

Luca La Paglia
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= Device Midi

It is possible to set a device for Midi both physical (Expander, Keyboard) and virtual (Roland

VSC, Miscrosoft SoftSynth, etc.).

The Refresh key updates the list if you have just connected a new device.

= Use Winlive Synth Engine (WSE)

This feature allows you to use the digital sound bank of the WINLIVE PRO SYNTH 12 without

being bound by external expanders.

= QOut

Default output for the output of the Midi stream with the possibility of setting the right or left

channel of the indicated output

=  Midi Out + WSE

Allows you to use the Winlive Synth Engine with a midi out to be selected in midi devices.

For example, if we use a vocalist device via midi, midi signals will be sent to both the winlive

internal synth and the vocalist.

= |t allows you to select another digital sound bank (soundfont .sf2) With X you can reset and
restore the Winlive sound bank

v’ Start from the First Note

If checked, it allows you to position yourself directly on the first note useful when opening the

Midi File, thus allowing immediate access.

v Stop on the last NOTE-OFF

If checked, it allows you to end the song at the last NOTE-OFF, truncating any tail of the sound.

= Midi tracks Vol% (1-100)

It allows the variation of the general volume of midi tracks in percentage.
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v' Midifile compression

Enables compression of note dynamics of midi files according to the min and max values set
below.

= Midi melody channel

Defines the midi channel for the melody (as standard set on midi channel 4)

= Metronome Device

It is possible to set a different device for the metronome, or use the same main device.
Warning: using a different device for the metronome could cause timing problems, due to any
different latencies of the midi device used.

= |nitial measures with metronome (pre-count)

The metronome will be played back up to the number of beats chosen after which it is
automatically turned off (it is convenient to use this function together with the de-selection of
start from the first note).

v Enter the metric

Enter from the first metronome movement

= Sounds of the Metronome

This part of the menu will allow you to change the sound of the metronome and set the
volume of it.

= Metronome compensation

It is used to "calibrate" the metronome if there are latency problems

= Metronome type

In the drop-down window below you can determine whether the Metronome is midi or audio
v' Markers in measures mode

As description

=*  Midiinput

Allows the connection of a keyboard or any MIDI IN device to play the internal sounds of the
WINLIVE externally.

= Ignore Midi track reading

Ignores the reading of parameters other than note on and note off of the track selected for
midi files, if set to off it is disabled

= Keyboard sensitivity

Adjusts the touch sensitivity on the midi keyboard possibly assigned in the midi input.
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= Resolution timer

Midi messages are sent in bulk every tot milliseconds. Usually 10 milliseconds is the optimal
resolution.

An increase in the timer decreases the CPU load but could clog the Midi device, a decrease
better distributes the midi messages but could weigh on slow CPUs.

In general, the default working range within which the time is perceptibly precise varies from 5
to 30 milliseconds.

= Midi Engine Multitasking

The multitasking midi engine allows the execution of multiple midi streams simultaneously,
increasing the loading and execution speed, excellent for computers with good performance.
v' Filter Non GM-GS messages

Leave out the redundant midi events considered useless for the reproduction of Midi files like
Control Change etc ...

Some devices with advanced functions such as Karaoke or Vocalist output, in combination with
some specific songs, may need to send these messages.

Deselect it only if you encounter such problems.

v’ Light Load

Leave out some midi events like Pitch-bend, AfterTouch etc ...

Enable it only if you experience slowdowns in Midi playback.

v Notes Partial OFF

An alternative way to use the pitch change reset, paused and at the end of the song.

Do not enable it if you use an Expander otherwise the notes will decay very slowly
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v Send Reset Sysex before the song

Send the Sysex standard reset message before each midi song, the type of reset message (GM,
GS etc.) can be chosen from the drop-down menu just below.

v' Program changes start at 1

By convention, the displayed program changes can start from 1 instead of 0 (only for visual
indication)

v Drum compatibility M-live Xlight

Exclude some drum kits that can block M-live xlight and M-live Xlight 2, do not select if you use
midi devices other than the two just listed.

v’ Ignore Sysex reset messages

Ignore the standard sysex reset messages already included in the midi file.

v' Ms waiting before the first note

Indicates the waiting time in milliseconds before starting the midifile

This mode is useful for older expander who need a waiting time to manage the flow of
incoming midi data in an optimal way.

v" Send SysEx Messages

Enable the sending of SysEx messages contained in the midi-file during playback.
Example: if the song contains 2 drum tracks, it is necessary to enable it to read the
corresponding SysEx message indicating to the midi device that track 9 or 11 is a drum Kkit.

v" Send SysEx Messages before start

Send a series of SysEx commands before the start of each song. Very useful for older expander
who use non-standard instructions.

Example: to send the GM reset, disable the "Send GS reset" option then paste the following
string on "Send SysEx messages before start": FO 7E 7F 09 01 F7

For the reset XG paste the following string: FO 43 10 4C 00 00 7E 00 F7

It is possible to choose whether to address SysEx messages only to the main Midi device or to
all devices.

v" Flow optimization

Optimize the data flow while playing the midi, it is recommended not to disable it.

v Hide info extra song sysex

As description

= Sysex timing

Set the delay time after sending a sysex message to the device.

v" Allow multiple midi outputs

It allows the use of multiple midi outputs when you want to manage multiple devices for the
same song.

Refer to the mixer in performance
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On this screen you can set up to 4 audio outputs and the audio present in the video

= Audio Device OUT1-0UT2-0UT3-0UT4
It is possible to set a device for the output audio typically a sound card.
And for each output we can decide whether to use it in stereo or mono (left or right)
The Refresh key updates the list if you have just connected a new device.
To reduce audio latency we can use ASIO DRIVERS or WASAPI DRIVERS depending on the
characteristics of the sound card in question.

= Audio Multi-Track vol
Here the volume for multitrack songs is set

v’ Cut the initial silence
If checked, it allows the execution of audio files starting directly from the first audible part. It is
useful to check it if you want immediate execution even for audio tracks, especially CDGs that
sometimes contain a silent part at the beginning that can last even more than 10 seconds.

v’ Fast loading
Ability to load on the fly, even faster on audio files.
The increase in speed is not very evident since Winlive is already very fast in a normal way. We
recommend that you enable this option only if you really need to play the backing tracks in real-
time as it may reduce the quality of the transpose on some sound cards.

v Pre-Load Audio
If checked, this option allows you to load the audio song into memory at the time of booking, so
that when it is played the song starts faster.
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v" MultiTask preload

If checked, this option allows you to speed up the loading of the songs.

v Time change without distortion

It allows the change of time without the song distorting.

v" Compression of volumes

Enable volume compression on audio, for details go to tools -> Winlive audio options.
v Enable Gain

Enable the use of gain in the virtual mixer.

= Audio Buffer

Set the buffer size. Increase this parameter in case of interruptions when playing audio and
video files. It is recommended not to decrease from the default value.

v Do not change pitch for second track
As description

®=  FFJump (seconds)

These are the jumping seconds when FastForward fast forward is chosen on an Audio
song,n [F] key.

= FadelN

Set possible fade IN fixed for audio songs (time expressed in Milliseconds).

= Fade OUT

Set possible fade OUT fixed for the audio songs (time expressed in Milliseconds).
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From this screen you can change the graphic theme of the program, the background image,
customize the colours of the text and the background as well as the character of the Karaoke and
more.

= Theme

Allows you to select a graphic theme for Winlive.

The theme affects the background and colour of the text, the fill and the shadows or effects.
v Use background image

If checked, it matches by default the background image of the theme for all executions.

v' Random images from a folder

It is possible to select a folder from which Winlive loads images randomly and associates them
with each song.

= Custom colours

Allows customization of colours for text, fill and so on

By extra line, we mean the extra lines following the running text

Background colour

In the absence of a background image, it is possible to change the background colour

Font

It is possible to establish a character common to all the text display modes

= Main Karaoke mode

| come seven modes and parameters for displaying the text in the main monitor

It is also possible to improve the graphic quality of karaoke (not recommended for "slow"
computers)
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= Monitor banner

Allows you to insert a banner in the karaoke monitor

= Monitor background

Allows you to customize the background of the main monitor and the Karaoke monitor.
v" Never hide monitor wallpaper

As a description

v’ Display logo in the karaoke monitor

In the absence of the tick, it does not display the WINLIVE logo in the middle of the Karaoke
Monitor. In WINLIVE logo in the upper right corner of the Karaoke monitor it is always
displayed

= Viewing images or pdf files

It is possible to decide where to display images or pdfs (scores or images) with various
visualization possibilities

= Advance - Postponement lyrics

Possibility of anticipating or postponing for a selected number of Milliseconds the scrolling of
the text according to the criteria of Midi File or Mp3.

=  Priority midi karaoke format

It may happen that several lyrics created with different programs are inserted inside the
midifile.

In this case Winlive, according to some internal criteria, can determine, automatically, which
lyrics to display.

Or one of two systems can be used: Karaoke meta events or Sysex format M-live

v’ Singing start bar

Possibility to display the start bar on the karaoke monitor and to move it.

v Bouncing Ball indicator

Displays an animation on the line or syllable of the scrolling karaoke text.

v Allow text sync and chords in wave files

Ability to insert lyrics and chords in audio files

v Automatically optimize karaoke for mp3

The mp3 text is optimized for a easily readable display

v' Optimize midi karaoke

The text in the midi files is optimized
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= Songlist sort type
It is possible to choose the sorting order for all the SongLists
ID = insertion order, the last inserted will go to the end
TITLE = by title, INTERPRETER = by interpreter, AUTHOR = by author,
GENRE_NOTES = for the genre of the song or for the relative annotations
TYPE = by type of song (e.g. midi, mp3, video, etc.)
The sorting order of the SonglList can be selected by combining different fields.
You can use the Order field, which allows you to make a customized sorting of the lists as defined
in the database. For a specific sorting for each SonglList, refer to the SongList editor function in the
instrument voice.
= Songlist cells
Allows you to set the size of the cells. Setting two cells per row gives you the largest dimensions
for the cells.
= Songlist columns
Allows you to set the number of columns to be displayed in the SonglList.
= Font size / SonglList cell
It allows you to set the font size within the cells of all the SongLists.
= Number of characters per cell
It is used to set the maximum number of characters that each cell must have.
= Songlist position
You can view the SongList at the bottom, left or right side
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v' Manage interpreter / author / time field etc.
Interpreter to the right of the title
It allows you to choose where to place the interpreter of a song.
= Typing in SonglList
It allows you to do a smart search, even writing only the first letters of the song.

=  Grid style
Allows you to adjust the border of the cells of all the SongLists.
= Text style

Allows you to adjust the evidence of the text within the SongLists.

= Songlist colours
It allows the variation of the colours displayed within the SongList, assigning a different colour for
each type of file, as well as for the background and selection.
v Highlight orphaned files in the SonglList
This important function identifies orphan files, i.e. files whose path does not match the one in the
database. If the files are blackened, it means that they are unplayable.
= Songlist font
Allows the adjustment of characters within the SongList.
v SonglList in Karaoke Monitor
It also allows you to view the SonglList on the second monitor.
v SonglList in Karaoke Monitor
View the Songlist also in the Karaoke Monitor.
v" Song done
Colour all the songs already played.
v Pre-load the SonglLists
Pre-loading of the SongList by increasing the display speed of the same
v Do not hide Songlist at the end of the song
At the end of each song, the SongList remains active even if there is no "closed padlock"
v Report song with Karaoke / 'K' chords
Signals the presence of the text or Chords through the letter K
v Use mouse wheel to scroll
The mouse wheel is enabled to scroll through the songs of the SongList in performance
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= Chords notation

= Allows you to leave the notation unchanged, or to convert all the chords that may be
contained in the files in Italian format (Do-Re-Mi ..) or in Anglo-Saxon format (C-D-E ..)
v’ Exclude Bass Revolt
If active, displays the Chords excluding the address, if any.
Example: Gsus / C will be displayed as Gsus
v Transpose chords based on the transpose
If active, the chord transposed follows the pitch change of the song (audio or midi). If deactivate,
leave the chords unchanged when the pitch change is performed.
v" Read Format CC # 1, GENERALMUSIC
It allows the reading of chords in particular formats. By enabling this option, information next to
the simple chords may be read in the chords field.
v Advanced CC # 1 chord scan
It allows the reading of "advanced" of chords in CC # 1 format
= Fill and plain text
It is possible to change the colour of the chords on the lyrics (Lectern with Chords mode), useful
for differentiating the Karaoke text from the chords.
v' Optimize the position of chords on the text where possible
As per description
= Chord Bar
Allows you to set the height dimension of the chord bar.
v" Sliding Chord Bar
Allows the chord bar to slide along with the song.
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= Number of cells in chord bar
Allows you to choose the number of cells inside the chord bar
v Chords in the melody bar
Allows chords to be inserted into the melody bar
= Colours of the chord bar
Choice of colours for the chord bar
= Automatic chords (midi song)
Ability to automatically calculate chords in midi files with various options
= View Txt and Rtf also in Karaoke Monitor
If checked, it allows the text to be displayed even within the Karaoke Monitor
= TXT font
Allows you to change the font, colour and size of the text beyond the background.
It is also possible to center the TXT text and the RTF text
= Automatic text scrolling

When associating a text (txt or rtf) with a file we can decide the scrolling speed of the text.

Remember that you can use the K and L keys to move forward or backward in the text.
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It is good to interact with these parameters only if you are fully aware of the structure and
characteristics of the Mp3 + CDG (Graphic Karaoke) files.

CDG (expert users)

v Personal background on the CDG

If enabled, use the current background colour instead of the original background colour in the
CDG.

v Use board on the GDG

Enable border colouring in the CDG where available.

Disabling, by default, allows an improvement in the reproduction of CDGs on the computer
that do not need a border like on a TV.

= Bias-Colour

You can adjust the RGB colour gamut (Red, Green, Blue), higher values result in greater
brightness for the respective colour gamut.

VIDEO FILES

= Video Engine

Select the video "engine" to read the files

v" Audio direct in line OUT 1

Enable if you want to route the audio of the video to OUT 1 output (Audio options)

= Audio Delay

Establishes the audio delay compared to video. It is used when there is no perfect synchrony
between video and audio
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v’ Video files only in the Karaoke monitor

The video file will be loaded only in the Karaoke monitor, while in the main monitor there will
be the text Karaoke.

v Do not use videos in the karaoke monitor

Activating this function the video will not be displayed on the Karaoke monitor decreasing the
video loading time.

v/ Maintain aspect ratio

Keep the video size equal to the original size.

v Associated video in loop

Associating a video file in this function will allow playback in the background continuously
(loop)

v Text on the video

It is not currently possible to display the text on a video but it can be positioned above or
below the video, only in the karaoke monitor or on both monitors
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OPERATIONS ON THE OPTIONS

e TO APPLY THE OPTIONS IT IS NECESSARY TO CLICK ON "APPLY"
e TO EXIT THE SCREEN BY LEAVING THE MODIFICATIONS CLICK ON "CANCEL"

With IMPORT you can import configuration options from one computer to another by exporting
them with EXPORT

With RESET (ALL) the "factory" configurations are restored

With RESET (Audio/Midi) the "factory" configurations are restored. Only for midi and audio
settings.

USE SETTINGS FOR MINIMUM REQUIREMENTS to set the minimum options compatible with less
performing computers

107



Extra/Help

GUIDE
Manuals and audio and video media related to the program are displayed

SHORTCUTS
Here is a list of keys (shortcuts) and related functions:

(Windows)

Spacebar Opens the SongList or Pause / Play of the Song

Arrow Keys Opens the relevant SonglList

F1,F2, ..., F10 Opens the relevant SonglList

Shift + [F1 .. F10] Opens the relative SongList

Ctrl + [F1 .. F10] Opens the relative SongList

Shift + Ctrl + [1 .. 0] Opens the relative SongList

1..2.3........ 0 Play from the relevant Lessor or silent channel

Shift + [1..0] Book the relative Lessor

Ctrl + [1..0] Reserves the relative Marker of the booked Song

Shift + Ctrl + [F1 .. F10] Jumps to the relative Marker of the booked Song

(o] Play from the beginning of the song

Q Fade Out to the booked Song

W Change the size of the Karaoke text (small Med. Grd.)

Shift + W Change the text mode in the Main monitor

Ctrl+ W Change the text mode in the karaoke monitor

F Next

R Back

M Melody (ch. 4) Yes / No [Song Midi]

T Restores the original Tempo [Song Midi]

U Solo Melody (Ch. 4) [Song Midi]

N Channels on / off as originally

P Talk Over (on key pressed)

A Activate all channels [Song Midi]

K, L Scroll for text in the lectern

D Drum only (Ch. 10) [Song Midi]

C Show / Hide chords

Shift + C Displays / Hides the Chords in the Karaoke Monitor

Y Mix with the booked Song

Shift + Y Manual Mixing (then press Y) of the booked song

H Scrolls through the mixing modes

X Opens the mixer

I Opens the Mixer in Instruments mode (you can press the 1..0 and Q
... Y keys for the On / Off tracks)

Vv Vocalist track (Ch. 16) Yes / No [Song Midi]

B Bass only (Ch. 2) and Drums (Ch. 10) [Song Midi]

Enter Send Play of the booked Song

Pause Pause / Play

+ Increase by a semitone

- Decrease of a semitone
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Pg. Up

Pg. Down

Ctrl + +

Ctrl + -

Ctrl + Pg. Up
Ctrl + Pg. Down
Ctrl+ M

End

Y

Backspace

Tab

S

J

E

Ctrl+Q/ Ctrl+S
Ctrl + K

Ctrl +)J

’

Shift + M

Shift + Pg. Up
Shift + Pg. Down
Shift + [F11]
Home

Del

Y

Tempo increase [Song Midi]

Tempo decrease [Song Midi]

Increase a Semitone of the booked song

Decrement of a Semitone of the Booked song

Tempo increase of the booked song [Midi and Audio]
Tempo Decrement of the booked Song [Midi and Audio]
Melody (Ch. 4) of the booked song Yes / No [Song Midi]
Stop the booked song (STOP)

Fullscreen mode

Opens the song search window in the SongList

Scrolls between occurrences of searches in the SonglList
Audio Sampler

Pre Listening

Show / Hide the Melody Bar

Virtual save current song

Enable / Disable the Karaoke Monitor

Enable / Disable the Clone Monitor

Enable / Disable Drum Part Off midi drums

Enable / Disable Drum Part Off midi percussion effects
Enable / Disable any second associated track

Increase the Song Volume

Decreases the Song Volume

Open the whole database

Open Song List

Only if in loop Markers: Exit the loop

Only if it is Groove (midi or audio) does it exit the groove at the end

Performance Display (With the SonglList open):

Home / Home
End

Initial

Space

Ins

Pg. Up

Pg. Down
Backspace
Tab

Enter / Return
Esc

Del

Pre Listening
Esc

oOoxr“-6o=xm

First column of the SongList

Last column of the SonglList

Search for the first song with the initial
Book the Song and close the SonglList
Insert the Song into the Temporary Song List (F10)
First line of the SonglList

Last line of the SongList

Search for a Song

Repeat search

Play of the Song and close the SonglList
Close the SongList

Only in F10: delete from the F10 list

Closes without saving

Next

Back

It positions itself at the point set with J and pauses
Set the position without closing the pre-listening
Position test without closing pre-listening

Start
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ENTER
SPACE

Audio Sampler

\

S

1.2.3.....0
CTRL+1..2.3.....

Open search
TAB

Shift + F11
Ctrl+T
Ctrl + 1
Ctrl+ G
Ctrl+ C
Ctrl+D
Ctrl+B
Ctrl+ A
Esc

In Database
Ctrl + K
ENTER

Esc

E

Closes by saving the Current position
Pre-listening pause / play area

Stop on all samplers

Opens / closes and stops all samplers
Play of the Sample

Select the set

Search Song in the current SonglList
Opens the entire database for research
Filter by title

Filter by interpreter

Filter by Genre

Filter by Artist / Composer

Filter by ID

Filter by Time or time range (from-to)
All songs no filter

Closes the search window

Enable / Disable the Karaoke Monitor
Send Play of the Song

Stop of the Song

Edit the database cell
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(Mac Osx)
Performance view (with the SongList closed):

Spacebar Opens the SongList or Pause / Play of the Song

Arrow Keys Opens the relevant SonglList

? + 2 digit number from 00 to 43 Opens the relative Songlist (43 = the whole database)

1..2.3........ 0 Play from the relevant Lessor or silent channel

Shift + [1..0] Book the relative Lessor

Ctrl + [1..0] Reserves the relative Marker of the booked Song

Shift + Ctrl + [F1 .. F10] Jumps to the relative Marker of the booked Song

(0] Play from the beginning of the song

Q Fade Out to the booked Song

W Change the size of the Karaoke text (small Med. Grd.)

Shift + W Change the text mode in the Main monitor

Ctrl + W Change the text mode in the karaoke monitor

F Next

R Back

M Melody (ch. 4) Yes / No [Song Midi]

T Restores the original Tempo [Song Midi]

U Solo Melody (Ch. 4) [Song Midi]

N Channels on / off as originally

P Talk Over (on key pressed)

A Activate all channels [Song Midi]

K, L Scroll for text in the lectern

D Drum only (Ch. 10) [Song Midi]

C Show / Hide chords

Shift + C Displays / Hides the Chords in the Karaoke Monitor

Y Mix with the booked Song

Shift + Y Manual Mixing (then press Y) of the booked song

H Scrolls through the mixing modes

X Opens the mixer

I Opens the Mixer in Instruments mode (you can press the 1..0 and Q
... Y keys for the On / Off tracks)

Vv Vocalist track (Ch. 16) Yes / No [Song Midi]

B Bass only (Ch. 2) and Drums (Ch. 10) [Song Midi]

Enter Send Play of the booked Song

Pause Pause / Play

+ Increase by a semitone

- Decrease of a semitone

Pg.Up Tempo increase [Song Midi]

Pg. Down Tempo decrease [Song Midi]

Ctrl + + Increase a Semitone of the booked song

Ctrl + - Decrement of a Semitone of the Booked song

Ctrl + Pg. Up Tempo increase of the booked song [Midi and Audio]

Ctrl + Pg. Down Tempo Decrement of the booked Song [Midi and Audio]

Ctrl+ M Melody (Ch. 4) of the booked song Yes / No [Song Midi]

End Stop the booked song (STOP)

Z Fullscreen mode

Backspace Opens the song search window in the SongList
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Tab

S

J

E

Ctrl+Q/ Ctrl+S
Ctrl + K

Ctrl +)

’

Shift+ M

Shift + Pg. Up
Shift + Pg. Down
Shift + [F11]
Home

Del

Y

Scrolls between occurrences of searches in the SonglList
Audio Sampler

Pre Listening

Show / Hide the Melody Bar

Virtual save current song

Enable / Disable the Karaoke Monitor

Enable / Disable the Clone Monitor

Enable / Disable Drum Part Off midi drums

Enable / Disable Drum Part Off midi percussion effects
Enable / Disable any second associated track

Increase the Song Volume

Decreases the Song Volume

Open the whole database

Open Song List

Only if in loop Markers: Exit the loop

Only if it is Groove (midi or audio) does it exit the groove at the end

Performance Display (With the SonglList open):

Home / Home
End

Initial

Space

Ins

Pg. Up

Pg. Down
Backspace
Tab

Enter / Return
Esc

Del

Pre Listening
Esc

oOxr“-6o=>m

ENTER
SPACE

First column of the SonglList

Last column of the SongList

Search for the first song with the initial
Book the Song and close the SonglList
Insert the Song into the Temporary Song List (F10)
First line of the SonglList

Last line of the SongList

Search for a Song

Repeat search

Play of the Song and close the SongList
Close the SongList

Only in F10: delete from the F10 list

Closes without saving

Next

Back

It positions itself at the point set with J and pauses
Set the position without closing the pre-listening
Position test without closing pre-listening

Start

Closes by saving the Current position

Pre-listening pause / play area
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Audio Sampler

\ Stop on all samplers

S Opens / closes and stops all samplers
1..2.3 ... 0 Play of the Sample

CTRL+1..2.3..... Select the set

Open search
TAB

Search Song in the current SonglList

Shift + F11 Opens the entire database for research
Ctrl+T Filter by title

Ctrl +1 Filter by interpreter

Ctrl+ G Filter by Genre

Ctrl+ C Filter by Artist / Composer

Ctrl+D Filter by ID

Ctrl +B Filter by Time or time range (from-to)
Ctrl+ A All songs no filter

Esc Closes the search window

In Database

Ctrl + K Enable / Disable the Karaoke Monitor
ENER Send Play of the Song

Esc Stop of the Song

E Edit the database cell

1) Winlive is structured to manage many functions while performing in a show or concert, through
the exclusive use of the computer keyboard thus avoiding the inconvenience of having to manage
the functions with the use of the mouse, which implies longer time.

2) It is advisable to keep a printout of the hot keys on hand, generally after a couple of
performances in order to memorize the keys and managing the program in a more immediate
way.

VIDEO TUTORIAL
We can connect with the latest video tutorial available on Youtube

MOBILE SOFTWARE (i0S/Android)
List of APPs for smartphones and tablets produced by Promusicsoftware. They are available for

both iOS and Android

WINLIVE ON FACEBOOK
The official Facebook page of Promusicsoftware

113



Demo Songs

DEMO SONGS
A songlist with various demo backing tracks

DEMO SONGS (MORE DOWNLOAD)
Other demonstration songs are provided

BACKING TRACKS
Links to major backing track producers
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Remote Support

This technical support allows you to connect directly ONLINE with Promusicsoftware technicians
for any info about some functions

This support is highly appreciated by all users of the PRO versions in fact by purchasing or
upgrading to Winlive Pro Synth 14 you are entitled to 120 minutes of free remote assistance
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Addendum

Specifications and compatibility

Funzione Caratteristica

midi, kar, mp3, wav, wmt, cdg, cdg-zip, avi, mpg, mp4, flv,

Fil ibility:
lle compatibility wma, Irc, txt, rtf, jpg, gif, bmp, ytb YouTube, pdf
Midi format compatibility: Tipo 0, Tipol, Smf 16 tracce

Tunel000, M-live, Solton, TextInKar, MP3TagV2, MP3 M-

Lyrics compatibility: liveText

Reset mode: GS, ensures full compatibility with most midi songs

Maximum number of songs in the list: [120.000

Maximum song number in database: |200.000

Average song access time: 0.05 - 0.2 sec. calculated on 2Gzh, 2GB ram
Number of pre-set sounds: 344 Instruments * + 32 DrumKit * + 32 User Sounds

The midi engine has been redesigned from scratch compared to all previous versions of Winlive,
therefore slight differences in reproduction may be noticed.

Now the management of the midi takes place totally in MultiTasking, an independent process
whereby it is now possible to open windows and programs while working on it, reducing Winlive
to anicon even during the execution of a Midi File, without incurring in slowdowns.

* There are a lot of usable midi sounds but, by convention, only the name of the first bank displayed on the
program (e.g. for Hard FM Piano bank024-pc: 006 the name ELECTRIC PIANO 2 bank will be displayed:
000- pc006). If the device is enabled to reproduce this sound, it will use the correct sound.
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LICENSE and LEGAL NOTICES

Winlive Pro user license

READ THIS DOCUMENT CAREFULLY BEFORE INSTALLING THE PROGRAM.

THE PROGRAM INCLUDED IN THIS PACKAGE IS LICENSED TO THE USER. BY INSTALLING AND ACTIVATING
THIS PROGRAM, YOU AGREE TO COMPLY WITH THE TERMS OF THIS LICENSE OF USE.

WARNING: THIS PROGRAM IS PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL TREATIES. THE
SOFTWARE PRODUCT IS LICENSED, IT IS NOT SOLD. UNAUTHORIZED REPRODUCTION OR DISTRIBUTION OF
THIS PROGRAM, OR PART OF ITS, MAY RESULT IN SEVERE CRIMINAL AND CIVIL PENALTIES..

1- User rights

PRO MUSIC SOFTWARE grants the end user the right to use one copy of the attached Software program on
a maximum of 2 computers and the software will be considered in use when it is installed on the temporary
memory (RAM) or on the permanent memory (hard disk, Cdrom or others) of the computer. The user
license is personal and is for the exclusive use of its owner..

2 - Copyright

The software and its copyrights are property of PRO MUSIC SOFTWARE and are protected by copyright
laws and international treaty provisions.

Making copies of the operation manual or other printed materials supplied with the software is forbidden.

3 - Warranty limits

RO MUSIC SOFTWARE guarantees that this Software will run in substantial conformity with the handbook.

To protection of the user, it will be possible ask for a new activation (up to n.2 in total) in case of computer
replacement prior unistalling program or in case of theft, loss of computer or formatting the OS. Software
specifications are subject to change and / or update without notice.

4 - Manufacturer ' s responsibility

PRO MUSIC SOFTWARE will not be responsible for damages (including without limitations: damage for loss
or lack of profit, interruption of activity, loss of information, endorsements or other economic losses)
deriving from use or incapability or improper use of the Software, even in the case the user has given notice
to PRO MUSIC SOFTWARE

5 - Installation

The software uses a self-installing installation package or an equivalent procedure designed to copy the
files for the operation of the software itself.

At the time of installation it will be possible to choose the installation path and other parameters. Note that
registry entries and system settings may be changed to allow for correct operation of the program itself.

6 - Right of withdrawal

PRO MUSIC SOFTWARE offers a detailed description of its software. Therefore, it is assumed that the buyer
has reviewed his/her product of choice, or used a trial version, and is satisfied with its quality before
effecting actual purchase of said product. With knowledge of the above, no refund/return request should
be solicited by the buyer/user on such basis. All software is non-refundable. PRO MUSIC SOFTWARE
guarantees the quality all its software products listed on this Web site.

7 - Other restrictions

The Setup-Package in this version of the software can be redistributed as it is, even partial and partial
reproduction of the individual files generated by the setup is prohibited.

The user license is intended for the exclusive use of the license holder.
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Credits and Thanks

A special thanks is due to all BetaTesters as well as those who have worked on our Forum in order
to make the program more and more in line with current standards, providing ideas and advice to
make the program more efficient and pleasant.

Ideator: Leonardo Di Pinto

Author and programmer: Pinto Giuseppe Massimo

Programmer consultant: Leonardo Cosmai

Technical consultant: Leonardo Di Pinto

Graphics: Di Pinto Girolamo (Gigi), Monti Francesco

Supervisor: Di Pinto Lucrezia (Lulu)

Contributors: Mary Chiaro, Di Pinto Girolamo (Gigi), Di Pinto Mariachiara, Acquafredda Francesco
External consultants: Vizzini Damiano, Kevin Lindop, Zen Massimo, Alberto Fontana, Lestingi
Giovanni, Dimarti Eber, Vernucci Massimo, De ludicibus Mauro, Portoghese Gianni, Del Vento
Sabino, Alex Ciccio Viola, Di San Leonardo Gaetano, Luca La Paglia, Gallo Daniele, Dos Santos
Freitas Ricardo

Made by ProMusicSoftware

‘ promusicsoftware

WWW.promusicsoftware.com
info@promusicsoftware.com

PROMUSICSOFTWARE - Bisceglie (BT) - Italy

This guide generally follows the version of Winlive Pro Synth 14, we are not responsible for any
omissions or inconsistencies as micro-updates released frequently may vary product specifications.
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	Other Controls ( SAMPLE PLAYER [S]
	Editor ( SONGLIST EDITOR
	In order from the left we will find:
	- the corresponding key to recall the Songlist;
	- the number of songs in each Songlist:
	- the name of the Songlists
	- by ticking the STOP box, the set list will stop playing, while not ticking it allows continuous play;
	- by ticking the MELODY box, each song in the list will be played without the melodic guide (midifile);
	- the ORDER function provides a drop-down menu from which you can select the order mode in which songs will be played (if we indicate TITLE, for example, we will have an alphabetical order, rather than by ID, by interpreter, by author and so on).
	DEFAULT ORDER: here we can select a general order as long as there is no specific order in the SongList.
	https://youtu.be/y5E5pEAKWag  Editor ( MIXING EDITOR
	With this function, it is possible to extract tracks from Audio CDs and save them in Wav or Mp3 format.
	It is necessary to select them (you can select them all through the "All" button or select them manually by clicking on the first column), then click on the Convert button.
	You can choose between uncompressed Wav (Wave not compressed) and Mp3, varying the quality according to your needs (eg "Minimal Only for voice store" generates a low quality file with the smallest footprint on disk, while "Maximum quality” generates a...
	This service, which can be purchased by subscription, allows you to analyze an audio or video track and split it into several tracks.
	Accept the terms and conditions before continuing.
	At the top are the daily minutes and the expiration date of the service.
	The minutes to be scaled are given by the duration of the track to be processed. For example, an audio song of 3 minutes and 40 seconds will scale our daily count by only 3 minutes.
	By Load Song we load the song we want to process.
	The buttons below allow us to put it on play, stop or go backward or forward.
	With the drop-down menu we can choose which function we want to use:
	-  Single track: no vocal: saves to an audio file excluding the vocal track.
	- 2 tracks: Vocal/Music: saves in *.Zip format or in *.wmt format (Winlive multitracks) the two separate tracks (vocal and music part)
	- 4 tracks: Vocal/Drum/Bass/Other: saves in *.Zip format or in *.wmt format (Winlive multitracks) the 4 separate tracks (vocals, drums, bass and other parts)
	- 6 tracks: Vocal/Drum/Bass/Other/piano/guitar: saves in *.Zip format or in *.wmt format (Winlive multitracks) the 6 separate tracks (vocals, drums, bass, guitar, piano and other parts)
	Clicking Process tracks starts the operation.
	For video files only the first function can be used (single track: no vocal) thus obtaining a video file without the vocal part.
	The processing is done on high-performance servers equipped with artificial intelligence (AI) algorithms so an Internet connection is required for these operations.
	The artificial intelligence algorithms are self-learning, which means they become increasingly accurate over time.
	UNDO cancels the last operation.
	Finally, by selecting the first track of our medley and pressing the TEST button at the bottom left, we can listen to the final medley and decide whether to save it in WAVE or MP3 format, selecting the various resolutions for the latter.
	If we want to save our project, perhaps to edit it later, we can click on FILE at the top and then save or load an existing project.
	Finally, remember that saving our medley will preserve lyrics and chords present in the various songs. In addition, markers will be inserted at the tracks in question.
	https://youtu.be/2fjdmpQt3kw REMOTE CONTROL
	The main functions of the Winlive can be remotely controlled via our APP available for both Android and iOS. Additionally you can view the lyrics on our mobile device.
	Totally free apps will be downloaded from:
	for iphone or ipad:
	https://apps.apple.com/it/app/winlive-remote-control/id1584198937
	for Android systems:
	https://play.google.com/store/apps/details?id=com.promusicsoftware.WinliveRemoteControl
	A necessary condition is that both the PC and the mobile device are on the same network. An internet connection is not required.
	By clicking on Remote Control, a screen will appear that will indicate the IP address of our PC.
	Open the APP on our mobile device and enter the same IP address as our PC.
	If we accept the connection, a message will appear where we can set the APP as MASTER or SLAVE.
	MASTER means that from our smartphone or tablet we can control our PC. If we decide to enable it as a SLAVE we can only view the texts included in the midi, mp3 and mp3-cdg files.
	In addition to the automatic saving in Video from the FILE menu we can record a video by capturing it directly from our screen. Clicking on this function will open the following screen
	OUTPUT FILENAME: We can decide what name to give to the file and where to save it
	VIDEO FORMAT: select the type of file to save (mp4 or avi)
	AREA: the area involved in the video saving is indicated.
	CUSTOM AREA: click on select area to select the size of the area
	WINLIVE PRO 12.0: select the area corresponding to the main Winlive window
	KARAOKE MONITOR: select the area corresponding to the karaoke monitor
	MONTOR 0: selects the entire area corresponding to the main monitor
	MONTOR 1: select the entire area corresponding to the Secondary monitor (if present)
	VIDEO SIZE: determines the resolution of the video format
	LOGO OVERLAY: here we can decide whether to superimpose one of our images on the video and decide both the position and the opacity
	SONG PERFORMED (List of songs played)
	All lists are stored in the \ HISTORY folder, which can be viewed in WinlivePro in documents.
	The RESET button allows you to delete all the contents of the list.
	CLOSE closes the function.
	With the OPEN search key, it is possible to search for the location of the lists.
	The drop-down menu allows you to select when to save the list:
	1 - each time the program is closed;
	2 - at the end of each song.
	PHYSICAL SAVING OF SONG
	Furthermore, it is possible to view and filter the songs according to certain features: for example, if we type the word ‘’WAY’’ then pressing the button ‘’TITLE’’, you could see only the songs that contain the word ‘’WAY’’.   POPUP MENU
	Clicking on right button of the mouse, on the main screen of Winlive it is possible to open a Popup Menu, from which you can have access to different functionalities:
	 Load File: read files quickly without inserting them in the database;
	 Save File: physical saving of files (see dedicated section);
	 Create or edit WMT file (Audio-Multitracks): allows editing or creating a multi-track audio file in the proprietary wmt (winlive multi tracks) format
	 Load song Audio multitrack: load an audio multitrack song (see dedicated section);
	 Events managment: Enable the Events Window feature to associate events with midi and audio files. This function generates an associated file with the extension * .wen
	 View Tracks: opens the screen to view note and audio events in midi and audio tracks
	 Set Folder: quick access to SongFolder List (F11 and F12);
	 Fullscreen: full screen view of the main screen;
	 Normal: restore the view with menu and control bar;
	 Minimize: the picture of Performane is closed as icon;
	 Window size: allows to reduce the window dimensions;
	 Use background image: displays or removes the background image;
	 Monitor Background: allows you to load an image as background
	 Karaoke Monitor: allows to enable the second screen (see dedicated section);
	CONTROL BAR

	It allows you to use the basic commands if we use WINLIVE on TABLET WINDOWS or touch screen.
	The F1 / F9, Shift F1 / F10, Ctrl F1 / F10, Shift + Ctrl F1 / F10 keys are used to select the SongLists;
	The names of the various songlists are given.
	Esc closes the list.
	the left and right arrows scroll the list in the commanded direction.
	the + F10 and - F10 keys remove or add songs in the provisional list F10.
	Start, allows you to start playing the selected song.
	Mix, allows mixing between one song and the next.
	the X button closes this screen.
	The recorded track will be associated with the song in database in the MEDIA column and in performance a Second Track window will appear next to the song title.
	Clicking on Second Track will open the following screen:
	From left to right you will find: the volume of the second track, the FX1 and FX2 effects that you can combine with the second track and their levels.
	Below with Offset (ms) we can anticipate or postpone in milliseconds the second track with respect to the song.
	Everything can be saved virtually with the quick save button
	If you want to export the song and its second track into a single audio or video file, you must press the SAVE FILE function in the File menu.
	In this mode we can edit different parameters of our song.

